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SAFETY

WARNING: To reduce the risk of fire or electric shock, do not expose this
appliance to rain or moisture.

CAUTION: To reduce the risk of fire or shock, do not remove screws. No user
serviceable parts inside. Refer servicing to qualified service personnel.

1. Obey all warnings on the VP4 and in this manual.

2. Keep away from sources of heat such as heat ducts, registers or appliances that
produce heat.

Keep the AC Adapter in good condition. Do not kink, bend, or pinch power cords.
If the cord becomes damaged, discard and replace the adapter.

If not using your VP4 for extended periods of time, disconnect from power.
Refer servicing to qualified personnel only.

Stop operation of the unit and obtain service if:

Liquids or excessive moisture enter the unit.

The unit operates incorrectly, or performance is inconsistent or erratic.

The unit has been dropped and/or the enclosure damaged.

oS P9 ® N gk w
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Prolonged exposure to high volume levels can cause hearing damage and/or
loss. The use of hearing protection in high volume situations is recommended.

A The VP4 is designed to be used with the included 9V DC 1.3A
negative center power supply. Operating the unit using a supply with
different specifications can cause problems including damage to
your VP4 or other connected equipment.

EMC/EMI

This equipment has been tested and found to comply with the limits for a Class B
Digital device, pursuant to part 15 of the FCC rules. These limits are designed to
provide reasonable protection against harmful interference in residential installations.
This equipment generates, uses and can radiate radio frequency energy and, if

not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. There is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference,
which can be determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following measures:

* Reorient or relocate the equipment or increase the separation between the devices.
« Connect the equipment to different outlets on different circuits.

+Consult the dealer or an experienced technician for help.
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Welcome Introducing the Setup Menu
Thank you for choosing the VP4 “Virtual Pedalboard” multi-FX processor from Fractal
Audio Systems. The VP4 offers up to four simultaneous effects with a user-friendly ] . . ) o . )
experience based on traditional pedals. It can be used between your guitar and amp It contains various global settings, options, utilities, and info, with pages for

or modeler for “Pre” effects, or with a modeler or an amp’s FX loop for “Post” effects. Audio, Pedals, Footswitches, MIDI/Remote, Settings, Reset, and System Info.
There's even a special global mode to enable "4CM" setups.

The Setup menu helps you make the most of the VP4.

A detailed guide to every option in the Setup menu begins on p. 44.
With hundreds of models from the award-winning Axe-Fx IlI-like Drives, Delays,
Reverbs, Modulation, Pitch, Plex, EQs, Compressors, Wah, Tremolo, and more—the

VP4 is a versatile new platform for any guitarist or musician looking to add great QEEN IHE SEI! !E MEN! |

effects to their sound.

ENTER EXIT
Uncompromising Sound Quality: True to Fractal Audio’s reputation, the VP4 delivers > Press ENTER and EXIT together. D D
pristine sound quality, suitable for use on stages or in the studio. » Use PAGE LEFT and PAGE RIGHT = e
“Fractal-Quality” Effects: The VP4 includes hundreds of different effects (435 as of to navigate the menu.
'[hIS W”tmgl) based on those in the aWard'Winning Axe-Fx Ill. » PreSS EXIT to go back to Wherever you came from

104 Presets: Each preset is like a different pedalboard with its own four effects,

effectively allowing one VP4 to replace an entire collection of pedals. Changes in SETUP are stored automatically as you make

Four Footswitches: These allow classic ON/OFF switching, making it intuitive and them. When this happens, the title bar of the VP4 will display
easy to use the VP4 like traditional pedals. “SAVING...". Do not power while the VP4 is saving, or your
Expression Pedals: Connect up to two expression pedals or switches for real-time most recent changes could be lost.

control. The Fractal Audio EV-1 and EV-2 are perfect for use with the VP4.

Advanced Options: While it is designed for simplicity, the VP4 also supports a number
the most popular optional features from our flagship Axe-Fx IlI, including scenes,
channels, modifiers, expert editing, and more.

Analog /0 with Unity Gain & Analog Bypass: Analog I/0 can be used in mono or
stereo and features unity gain. In addition, the unit features optional analog buffered
bypass, which entirely removes all processing from the signal path.

SPDIF digital /0, USB, MIDI I/0, and more: The VP4 also includes a suite of extra I/0
for enhanced versatility.

VP4-Edit: This comprehensive software editor and librarian makes it easy to manage
and customize your VP4. It is free and can be found on our web site.

Upgradeable Firmware: The VP4 features upgradeable firmware, ensuring that you
always have access to the latest improvements and features.

The VP4 Virtual Pedalboard was designed for musicians—by musicians—to offer great
sound and versatility in an easy-to-use, compact, and reliable unit. We look forward

to the music you will create using the VP4, and we thank you, as always, for choosing
Fractal Audio Systems.
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VP4 in 60 Seconds

CONNECT THE VP4

The following is for a typical mono “Pedalboard” setup.
Other setup options such as FX Loop/Post are shown starting on p. 17.

» Connect your guitar to VP4 Input L/Mono.
» You can also connect other pedals before or after the VP4.

» Connect VP4 Output L/Mono to the input of your amp or modeler.
o Use standard patch cables.

» Connect the provided AC adapter to the VP4 and turn it on.

VIRTUALPEDALBOARD

» By default, the VP4 boots into Effects Mode (blue LEDs)
In Effects Mode, the four footswitches turn effects ON or OFF.

» You can change the MODE for other options (at right, and next page).

EDIT EFFECTS

» To edit an effect, turn SELECT to highlight it and then press ENTER.

» Use the ABCD and SELECT knobs to adjust settings. Some effects
have multiple pages. Press EXIT when you're finished.

» To change Block Type (Drive, Reverb, etc.) go to the
Home page in Effects Mode and turn ABCD.

BROWSE PRESETS

» The VP4 stores 104 Presets. Each preset can have its own FX and settings.

» To load a preset, change to Preset Mode and:
o Use the footswitches (see next page)
o OR, turn Knob A to browse the presets list and press ENTER to confirm.

See p. 25 for more on Editing.

See p. 23 for more on Presets.

SAVE CHANGES

» To save changes to the current preset, press SAVE then ENTER.

» Use SELECT and ABCD to choose a location to save to. Edit the preset
name and scene names if desired. Press ENTER 2x to confirm.

See p. 27 for more on Saving

INTRODUCTION

Four Modes

The VP4 has four modes: Presets, Scenes, Effects, and Tuner/Tempo.

Different modes have different footswitch functions and also change the
appearance of the Home page and what some of the knobs and buttons do.

SELECT A MODE
Use the MODE SELECT page to change the mode. To access Mode Select:

— MODE —
HOME SAVE

1 2
0+0 (

Press HOME+SAVE buttons together.

Press switches 1+2 together.

In Mode Select, use the footswitches to choose a mode:

[ C— o [C— —>
Preset Mode Scene Mode Effects Mode Tuner Mode
(Green) (Red) (Blue) (Yellow)

On the Home page the mode changes automatically as you turn SELECT
to highlight the Preset name, Scene name, or one of the Effects.

FOOTSWITCHES

The four footswitches do different things in different modes.

Default settings appear on the next page.
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. tel | “Gia Mode”

INTRODUCTION

The VP4 offers a convenient master setting called GIG MODE that's enabled by default. With this setting active, you can access Presets, Banks, Scenes, Effects,
Channels, Tuner, and Tap Tempo using simple tap and hold options across the four footswitches.

ALL MODES MODE SELECT
TAP footswitch combos for special actions. TAP any switch choose a mode.
MODE SELECT TUNER/TEMPO MODE 1 2 3 4
@ - O O O O
@) @) @) PRESET SCENE EFFECTS TUNER/TEMPO
MODE MODE MODE MODE
PRESET MODE SCENE MODE
« TAP any switch to load a Preset from the current Bank. ~ TAP any switch to load a Scene from the current Preset.
1 2 3 q 1 3 i}
® 6 6 o 6 6 6
$HOLD 1: YHOLD 4: $HOLD 1: ¥ HOLD 4:
Previous Bank Next Bank Previous Preset Next Preset
EFFECTS MODE TUNER/TEMPO MODE
~ TAP any switch to Bypass or Engage the corresponding effect.
1 2 3 4
- - e - v TAP Switch 1 v TAP Switch 4
@) @) @) @) for TAP TEMPO to EXIT the TUNER

¥ HOLD any Switch to show the four Channels for that effect. 1 2 3 4

® ® © © © O

CHANA CHAN B CHAN c CHAN D v TAP SWltCh 3
to MUTE/UNMUTE

~ TAP to select a channel and exit. $HOLD to select and stay.

Note: The default “Press and Hold” options cause the “TAP” functions of the footswitches to activate on the “upstroke” of the switch.
See p. 46 for more on the timing of tap and hold switches.
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INTRODUCTION

]j]g_Hg_mg_Eagg The home page is designed to help you set up the VP4 and use it during performances.

The VP4 contains
104 PRESETS.

Presets are grouped ...

in BANKS (A-2)
containing four
presets each.

See p. 23 for more
about presets.

© Each preset also
contains four SCENES.

» Scenes are a power user
feature that can reduce
the need to “tap dance”
on FX footswitches—and
much more. See p. 34

for more about Scenes.

4CM Indicator Pages Display

Mini Tuner CPU Meter

Page Title

4cn/:|2/2 &0 |:| NI |><] CPU:63%. ®

‘A1l: Preset Name
S1: Scene Name

4 A

—
WA

\. A J

(000 |

DIRY

M) )

DLLY

A

TIP TEXT

Knob A Label

Knob B Label

Knob C Label

Knob D Label

Labels show the functions of ABCD knobs on many pages.

“Edited” ® appears

here whenever there
are unsaved changes
to the current preset.

Each preset can have four
effects. You'll find Drives, Delays,
Reverbs, Modulation FX, EQs,
and many more.

See p. 25 for more on effects.

© The letter beneath each effect
shows its current CHANNEL.

«“Channels” are a power user feature
that can add great sonic flexibility to
a single preset. See p. 55 for more.

Other Pages

The different areas of the VP4 use different types of pages containing various settings and options.

< SELECT »

T® © O
10 O O O A"'F'{'F"”D

Use the ABCD and Select knobs to navigate these pages and make changes.

< SELECT »

< SELECT »

: A I
. iB Rate

:C Tone

iD Mix

Balance

A B (

E Time Time Time

w. Rate Rate Rate

7 Tone Tone Tone

v Mix Mix Mix
Level Level Level
Balance Balance Balance
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Top Panel

INTRODUCTION

000000 CPU63% C

HOME . ,,,,,,
A1: Classic Gig Pedalboard

S1: Yes to Everything

ool

_....:RAETAL
AUDIO SYSTEMS

Channel

-0 O O O

HOME - SAVE BUTTON COMBOS
<4PAGE PAGE» % HCI'M_E MDDE;VE
6 @ It HOME + SAVE: Press
— seTup— these at the same time
SELECT to show MODE SELECT.
Seep.5

OO0

ENTER EXIT

1 2 3 LI' — SETUP —!

—> —> —> —> ENTER + EXIT: Press at
N N N N the same time to show the
a @ N @

“C )) ‘@’ ‘@’ ( )) SETUP menu. See p. 4

° - for an intro to this area.

€@ DISPLAY — The display is a
high contrast color LCD.

@ BUTTONS - Six buttons operate the VP4:
« HOME: Press this to show the Home Page at any time. See p. 7.
* SAVE: Press this to save the current Preset. See p. 27.

* < PAGE LEFT and PAGE RIGHT » : Use these to navigate left and right
through any menu. Icons in the title bar show where you are. A OO0 0

« ENTER, EXIT: These confirm or cancel various options, and also perform
special actions. Some pages show tips. For example, with an Effect
block selected on the Home page, you will see,

“ENTER = Edit Selected Effect”.
ENTER is also used to add a Modifier for remote control or realtime
parameter changes. Learn more beginning on p. 38.

0 ABCD knobs — Turn the knobs to adjust on-screen settings. In a vertical
menu or grid, look for labels that show how the knobs map to controls.

o SELECT knob: Highlights different areas of the current page. For
instance, if the page displays multiple rows of controls, turning the
SELECT knob will switch between the rows. Once a row is highlighted,
use the ABCD knobs to adjust the controls in that selected row.

NOTE: On the HOME page, select also changes the Mode. See p. 5

Footswitches — The four footswitches use our proprietary Solid State
Switching (SSS™) technology, ensuring smooth, quiet operation with no
mechanical contacts to fail. Their default functions vary based on the
currently selected Mode. See p. 6.

Note: The default “Press and Hold” options cause the footswitches to fire when you release
instead of when you tap. You can disable or customize press and hold using
SETUP > Footswitches. See p. 46 for more on this.
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Back Panel

INTRODUCTION

/) /M. )Y Y M
& FRACTAL AUDIO SYSTEMS
INPUTS DUTPUTS PEDAL
LIMuno LIMuno

__MiDI__ _POWER

IQ
=9

G 0

0 INPUTS — Connect your guitar, bass or other instrument to Input L/Mono

using a standard patch cable. You can also connect the outputs of pedals,

modelers, as well as the line level signal of an amp’s effects loop “Send".

0 Input Levels: the VP4 comes set for a typical guitar with hot pickups. If
input clipping occurs, an IN CLIP warning is displayed and the Input Pad
setting is temporarily increased. See p. 10 for more on Input Levels.

Mono vs. Stereo Input: The VP4 defaults to “MONO” input mode. When
using the VP4 with stereo input signals, use both Left and Right inputs
and set SETUP > Audio > Input Mode to “STEREQ". Don't use the R input
for mono or connect to only one input in stereo. See p. 10 for more.

o OUTPUTS — Connect the VP4 QOutput(s) to the input(s) of your amplifier,
modeler, or other pedals using standard patch cables.

0 Output Levels: With no effects, the VP4 outputs a unity gain signal.
Output levels will increase or decrease based on the settings of Presets,
Scenes, and Effects. If output clipping occurs, an OUT CLIP warning is
displayed. See p. 11 for more.

€ Mono vs. Stereo Output: The VP4 defaults to “STEREQ” output, which is
also compatible with mono setups, but other settings are also available.
See p. 11 for more.

WARNING: The VP4 is designed for instrument or line level signals. Connecting it to
the “Speaker” output of an amp will cause serious damage the VP4 and/or your amp.

0
o

[10)

o

[12)

0@@ —0

PEDAL jacks — The VP4 has two jacks for connecting expression pedals
like the Fractal Audio EV-1 and EV-2. Alternatively, a single momentary or
latching switch can be connected in place of an expression pedal.

When you first connect a pedal or switch it needs to be configured.
Learn more starting on p. 13.

SPDIF DIGITAL 1/0 — For connecting devices with SPDIF digital I/0. The
VP4 operates at a fixed clock rate of 48kHz. The SPDIF output always
mirrors the signal at the analog outputs. To use the SPDIF input, you
must first select it manually in SETUP > Input Source.

USB — The VP4 is also a high quality, 2x2, 24-bit/48kHz audio interface
for Mac and Windows computers, with added MIDI-over-USB capability
for connecting to VP4-Edit, Fractal-Bot, or any DAW or computer MIDI
application. See USB on p. 15 for more.

MIDI — The VP4 features 3.5 mm MIDI In and Out ports for modern,
space-saving connectivity. To connect to traditional 5-pin MIDI hardware,
a “Type A" 3.5 mm to 5-pin DIN adapter is required. These are available at
shop.fractalaudio.com The optional SETUP > MIDI/Remote > MIDI Thru
setting can be enabled to echo messages from In to Out. A detailed MIDI
implementation can be found on p. 55.

POWER — Connect the provided 9V DC 1.3A AC Adapter here and

use the power switch to turn the VP4 on or off. The VP4 features pop
suppression, but amps/speakers in a rig should still always be turned off
first and on last.


http://shop.fractalaudio.com
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INTRODUCTION

Input Level

The VP4 features an adjustable input pad that allows it to accept signals
ranging from very quiet vintage guitars to loud pedals, effects sends, or
modelers.

The Input Pad setting can be adjusted from 0 dB (for low-level input signals)
to 6 dB, 12 dB, or 18 dB (for progressively louder input signals). The default
Input Pad setting is 12 dB, which is ideal for guitars with hot pickups.

When the input clips, a red “IN CLIP” warning appears in the title bar,
indicating the need to increase the Input Pad setting.

Automatic Input Pad Adjustment

If the input of the VP4 clips persistently, the unit will automatically increase
the Input Pad setting. When this occurs, the word “Auto” will appear next to
the Input Pad value, for example: “12 dB (Auto)” indicating that the pad was
automatically increased to 12 dB. When you reboot the VP4, the automatic
setting is cleared, and the last manually selected value is restored. If you
want to make the automatic pad setting permanent, just turn the Input Pad
knob one “click” to clear “Auto”.

ADJUST THE INPUTPAD:
» Open SETUP > Audio > Input Pad.

» Play loudly and watch the meter. The input meter will turn red
and “IN CLIP” will appear in the title bar if clipping occurs.

» Increase the Input Pad setting as high as necessary to prevent
clipping. Be aware that increasing the pad setting also raises
the noise floor, so set it as low as possible without clipping.

& If input clipping still occurs with the Input Pad setting at the
maximum value of 18dB, decrease levels upstream from the VPA4.

Note that while 4CM Routing is enabled, a common Input Pad setting is
shared by both Left (Pre) and Right (Post) inputs.

Input: Mono vs. Stereo

M B |

s T B
The VP4 defaults to “MONO” input mode, — ~ FRASTAL AUDIO
with SETUP > Audio > Input Mode set to Uano R /\ PN
“MONO”. Use only the Left/Mono input for @ Q) ©
mono signals. © o
NOTE: SPDIF and USB inputs always operate
in stereo, regardless of settings.

S FRACTAL AUDIO
For stereo input signals, always connect to T T =

both Left and Right inputs and change
SETUP > Audio > Input Mode to “STEREQ".

EdLL

NOTE: SPDIF and USB outputs are tapped after the setting for SETUP > Audio > Output Mode.
These outputs use a stereo format, but the signal may be heard in mono depending on the above setting.

Note that the Input Mode setting is overridden when the global 4CM Routing
option is "ENABLED". 4CM routing passes the signal from Input L/Mono to
"Pre" effects and the signal from Input R to "Post" effects.

FAQ: Are the Effects Mono or Stereo?

Most of the Effect Blocks in the VP4 process full stereo, in and out: Chorus,
Compressor, Enhancer, Filter, Flanger, Formant, Gate, GEQ, PEQ, Phaser,
Resonator, Tremolo/Panner Volume/Pan, Wah.

Some blocks sum the input signal to mono internally and then produce a
stereo output: Multitap Delay, Plex, Reverb, Rotary, Synth.

Drive always processes the input in mono and outputs a mono signal.
Ringmod produces a mono effect but the dry signal remains stereo.

Delay, Pitch, and some others offer a combination of mono and stereo types
but always pass the dry signal in stereo.

Note 1: Some stereo effects contain internal settings such as “Stereo Spread” that can
be used to collapse a stereo signal back to mono.

Note 2: Stereo versions of mono effects are possible using two parallel blocks with
expert settings for Input Select and Balance.
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Output Level

ADJUSTING QUTPUTLEVELS

Check the levels of individual effects. The edit menu for every effect includes
a Level control, or you can open the Preset Mix/Routing page to adjust all four
effect levels in one place.

Every preset also includes a master Preset Level control plus controls to
adjust all four Scene levels. Find these on the Preset Main Levels page
(Press HOME, then Page Right 2x).

Remember that the Input Gate also includes a Level control.

UNITY GAIN

With no effects and no adjustments, the VP4 outputs a unity gain signal.
Overall output levels can change based on the settings of your effects,
presets, and scenes. If output clipping occurs, an OUT CLIP warning is
displayed. Adjust effect/reset/scene levels to address this.

TIP: Delay, Multitap Delay, Megatap Delay, Plex Delay, and Reverb effects have
a default setting called Bypass Mode: MUTE FX IN which allows effect tails
to spill over when the effect is bypassed. As you turn Mix higher than 50% in
these effects, the dry level will gradually decrease, until it is entirely silent at
Mix 100% — even when the effect is bypassed. If you want to maintain unity
gain when bypassing one of these effects with its Mix above 50%, change its
Bypass Mode to “THRU". This kills spillover, but preserves unity gain.

ANALOG BYPASS

The VP4 features buffered analog bypass. This passes signal directly from the
input to the output with no digital conversion, latency, or digital processing.

If you want to control analog bypass with a footswitch, set Press & Hold for
any footswitch to “VP4 BYPASS" in SETUP > Footswitches.

If you want analog bypass to turn on automatically whenever all four effects
are bypassed, enable SETUP > Global Settings > Automatic VP4 Bypass.

If you want to control analog bypass using a connected pedal/switch or MIDI,
choose the desired option in SETUP > MIDI/Remote > VP4 Bypass.

INTRODUCTION

Qutput: Mono vs. Stereo
The VP4 defaults to “STEREQ” output mode. This setting is effectively also
compatible with mono setups, but several other options are available under

SETUP > Audio > Output Mode. Here is an overview of several scenarios, with
recommended settings for each.

» Stereo: No special settings required. Connect the VP4 outputs to
two amps or to the dual inputs of stereo pedals or processors.

» “Half Stereo”: Leave the VP4 in its default stereo configuration
but connect only the left output to a mono input for a “half-
stereo” setup. You may find that certain sound settings produce
unusual or unexpected results. For example, a “panner” will
sound like a tremolo when one side is missing. A ping-pong delay
may “ping” but never “pong.” Compare “SUM L+R" below.

» Copy L>R: If you want to force your rig to mono, “dual mono” is also
an option. Sonically, this is identical to using the left channel in half-
stereo (above), except that the mono signal is output at both the
left and right jacks for use with two mono amps. To switch to dual
mono, change SETUP > Audio Output Mode to “COPY L->R".

» SUM L+R: In this setup, left and right channels are internally combined,
with a “summed mono” signal sent to both left and right outputs. This
has the advantage of not discarding half of the sound, but certain stereo
signals can be problematic when summed to mono. For example, short
delays or phase differences between channels can result in strange
artifacts or even total cancellation. Take the "2290" style delay. Like the
effect it is based on, the right channel of the wet signal is phase inverted,
so the effect is silent when summed to mono! To switch to summed
mono, change SETUP > Audio Output Mode to “SUM L+R".

(In addition to "2290 w/Modulation" this applies to Warm Stereo Delay,
80s Style Chorus, Triangle Chorus, and Warm Stereo Chorus.)

» Note that the Output Mode setting is overridden when the global 4CM
Routing option is "ENABLED". 4CM passes the signal from "Pre" effects in
mono to Output L, and the signal from "Post" effects in mono to Output R.
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Tuner

TUNER &

The VP4 offers a precise tuner with a bar graph, arrows for flat or sharp, and a
virtual strobe that rotates clockwise for sharp and counterclockwise for flat.
In the default “Gig Mode” there are multiple ways to show the tuner:

» Press Footswitches 3 + 4 at the same time.
» Use Mode Select (see p. 5).

By default, the tuner mutes the VP4 input. This mute turns off when you exit
the tuner, or you can tap footswitch 3 to toggle the mute on/off. See below for
additional tuner Mute Type options.

You can exit the tuner the same way you opened it, or just tap Footswitch 4.

P <] TIP: Most pages also include a “Mini Tuner” in the title bar.

From the tuner, you can press PAGE RIGHT to show the global tuner options:

0 - 4 Semitones

PARAMETER Description.
Mute Type “Auto” options engage the mute every time the tuner is opened.
Auto In You can un-mute and re-mute manually using footswitch 3.
Auto Out “Manual” options require you to tap footswitch 3 to mute the
Manual In tuner.
Manual Out Both “In” options mute at the input. Tails ring out.

Both “Out” options mute at the output. Tails are silenced.
Display Mode Determines whether the tuner shows note names for accidentals
MIXED/FLATS/SHARPS as Sharps, Flats, or a mix of both.
Calibration Calibrates the tuner. The tuner defaults to A440.
Downtune The Downtune control makes tuning feel more familiar when

your guitar is tuned down. For example, if your guitar is tuned
down half a step to Eb, setting Downtune to “1” will show the
notes in the tuner as if the guitar were in standard E tuning. This
keeps everything consistent, and any effects that use pitch will
adjust automatically when Downtune is on.

Use Offsets
OFF/ON

1st, 2nd, 3rd, etc.

Use Offsets determines whether the six offset settings are
applied or ignored. Offsets allow the tuner to adjust individual
notes slightly away from standard tuning. This is useful for
specific tuning systems like Buzz Feiten tuning.

The offset range is +/- 25 cents.

TEMPO

Tempo

Footswitch 1 in Tuner mode is the Tap Tempo footswitch, allowing you to set
the global tempo of the VP4. Fine adjustments can be made using Knob A on
the Tuner page.

USING THE TEMPO

Many VP4 effects have parameters that can sync to the tempo, such as delay
time, tremolo speed, and sequencer steps. Tempo sync is not a global setting;
it must be enabled for each parameter in any effect in a preset.

Tempo parameters appear as Time Tempo

a separate option alongside

the setting they control. For @ NONE
example, in the “Digital Mono

Delay," you'll see both the “Time” 500 ms

control and the corresponding

“Tempo” control.

When Tempo is set to Time Tempo

a rhythmic value, the

corresponding time or rate @ 1/8 DOT

control is disabled. Its current
value is shown in parentheses,
and a warning appears if you
attempt to change it.

(375 ms)

Every preset also has a setting that determines whether it should change
the tempo when it is loaded. See Controllers > Tempo “Tempo to Use” on
p. 42 for more.
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Expression Pedals

PEDALS &

The VP4 has two jacks for connecting external expression pedals or switches.
Each jack can host one pedal or one switch. Pedals allow realtime control of
effects like wah, whammy, and many more, and they can also be assigned to
global Volume options. Switches can similarly be used to control effects, and

they too can be assigned to global options including Tempo, Bypass, and more.

EXPRESSION NNECT & CALIBRATE A PEDAL

PEDAL Expression pedals should have a linear resistance taper
- and must have a maximum resistance in the range of
10-100kQ. Expression pedals must be used with Tip-
Ring-Sleeve (TRS) cables.

1. Connect an expression pedal to one of the VP4
Pedal jacks using a TRS-to-TRS cable.

2. Open SETUP>Pedals.

TRS 3. For pedal jack 1, set Pedal 1 Type to
“EXPRESSION PEDAL".

2 For pedal jack 2, use Pedal 2 Type instead
i 4. Select the Calibrate option and press ENTER.
E Follow the on-screen instructions to perform
Calibration.
TRS 6. Check your pedal by sweeping it through the

entire range and watching the on screen meter.
PEDALJACK1or2 7. Press HOME when finished.

different setups.

FRACTAL AUDIO EV-1 & EV-2

The Fractal Audio EV-1 (full-sized) and EV-2
(compact) are perfect for use with the VP4.
They deliver smooth, linear control and are
built tough. Both pedals also double as
analog volume pedals, offering versatility for

SWITCHES

ASSIGNING A PEDAL FOR EFFECT CONTROL

Expression pedals can be used to control sound settings using a Modifier with
its SOURCE set to “PEDAL 1" or 2. Modifiers are saved with the preset rather
than operating globally. Typical uses include controlling wah, whammy, or
volume but there are countless possibilities. Learn more starting on p. 38.

ASSIGNING A PEDAL FOR GLOBALVOLUME =~

Pedals can also be assigned globally to Input Volume or Output Volume,
eliminating the need to add a Volume effect block in every preset.

1. Open SETUP>MIDI/Remote.

2. Turn SELECT to Input Volume or Output Volume.

3. Turn Knob A to set the value to “PEDAL 1" or “PEDAL 2".
4. Press HOME when finished.

TUNERONHEELDOWN

The VP4 can automatically show the tuner when a connected pedal, switch, or
MIDI controller is in the low position (“heel down”).

1. Open SETUP>MIDI/Remote.

2. Turn SELECT to Tuner on Heel Down.

3. Turn Knob A to set the value to “PEDAL 1" or “PEDAL 2".
4. Press HOME when finished.

FAQ: Expression Pedals &
Factory Presets

Some VP4 Factory Presets use expression pedals
with “Auto Engage,” a feature that engages the
effect when you move the pedal. This disables the
footswitch that normally turns the effect on or off.
Auto-Engage is a feature of the “Modifier” system.
Learn more starting on p. 38
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External Switches

Each of the VP4 pedal jacks can be used to connect a single switch instead. Switches provide on/off
simplicity to control sound parameters or global settings.

For a single switch, connect to one of the VP4 Pedal jacks with a patch cable.
For a dual switch, connect to both pedal jacks of the VP4 using a TRS “insert” cable.

SET UP A SWITCH SINGLE SWITCH DUAL SWITCH

1. Connect your switch(es) as shown (left).
2.
3

Open SETUP>Pedals.

For the “Pedal 1", set Pedal 1 Type to the TS
appropriate “SWITCH" option:

o Choose “SWITCH (Any, Follow Hardware)” when you
connect either a latching/toggle switch, or when you
connect a momentary switch and want it to work as a
momentary switch.

o Choose “SWITCH (Momentary, Virtual Toggle)” when you
connect a momentary switch but want it to work as a
latching/toggle switch.

4. Press HOME when finished.

TRS

-
X

Insert Cable

Guitar Cable

TS
FAQ: Momentary/Latching

_ ] ; PEDAL JACK 1 or 2 PEDAL JACK 1 AND 2
Switches are available in two formats: momentary

and toggle/latching. Momentary switches stay w"ypa |8 8w| == ypg | 5w
: N ) . . 88 88
active only while be.lng prgssed, like a piano sustain 55506 B 558 B
pedal. Toggle/latching switches remain engaged = - - | = = -
until you click them again, like a classic stompbox. 6 o o o66||6 © ©6 6

Either type can be used with the VP4, but
momentary switches are more flexible because
they can be also used to create “Virtual Toggle”
switches with tap on/tap off action.

ASSIGN A SWITCH FOR EFFECT CONTROL

External Switches can be used to control sound
settings using a Modifier with its SOURCE set to
“PEDAL 1" or “PEDAL 2". Modifiers are saved with
the preset rather than working globally. Typical
uses include controlling delay hold, rotary speed,
or drive “boost”, but there are countless creative
possibilities. Learn more starting on p. 38.

ASSIGN A SWITCH TO A GLOBAL FUNCTION

External Switches can also be assigned globally to
Input or Output volume as a “Kill Switch,” or to “Tap
Tempo” or “VP4 Bypass”.

1. Open SETUP>MIDI/Remote.

2. Turn SELECT to the desired option.

3. Turn Knob A to select “PEDAL 1" or “PEDAL 2".
4. Press HOME when finished.
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USB

USB provides the VP4 with a host of great audio features. With 2x2 channels,
you can record the output or the input of the VP4, play back computer audio
at the outputs of the VP4, or send signal from the computer to the VP4 for

processing.
USB INPUTS (RECORDING)
@ @ Processor Record stereo processed audio
Output from the VP4 outputs.
INF:UTS Record unprocessed audio
@ @ INTL+R from the VP4 input(s)
USB OUTPUTS (PLAYBACK)
OUTPUTS Play Computer Audio
@ @ umﬁm @ @ OUT 1L+R at the VP4 output.
@ @ (o oo e ), ProcCessor Route Computer Audio
iy Input to the VP4 for processing.

Note: Connecting the VP4 to some computers can cause a USB ground loop
which can produce unwanted noise. To eliminate this noise, disconnect USB, or
try a USB isolator or audio isolation transformer(s) in your rig.

FAQ: Why would USB cause noise or hum?

A computer can create a ground loop with a guitar amp when the VP4 is
connected to both. To address this, consider using a USB Audio Ground
Loop Eliminator (Type C > C) between the VP4 and the computer, or an audio
isolation transformer between the VP4 and the amp. Also, if you're using a
laptop, try switching from AC power to battery power or vice versa.

MA MINIMUM REQUIREMENT

0S: 0S X 10.13 or newer. (Older versions may work but are not supported).
CPU: Intel Processor or Apple Silicon.

Memory: 512MB minimum.

USB: USB 2.0 support required.

Driver: No driver is required for Mac 0S.

WINDOWS MINIMUM REQUIREMENTS

0S: Windows 10 or newer

CPU: Intel Core 2 @1.6 GHz or better, or AMD equivalent.
Memory: 1GB minimum.

USB: USB 2.0 support required.

Driver: A USB driver is required for Windows operating systems. The Windows
driver can be downloaded from http:/www.fractalaudio.com/vp4-downloads
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VP4-Edit

VP4-Edit is a free, intuitive software editor for the VP4. This app allows you

to easily create, edit, and manage your VP4 from your connected Mac or PC,
providing a fast and user-friendly interface. Whether you're dialing in effects,
building scenes, or managing presets, VP4-Edit simplifies the process, helping
you get the most out of your unit. It even includes bonus features not available
on the VP4 itself, such as Block Library, Channel Copy, Scene Swap, and more.

You can download VP4-Edit for Mac or Windows at:
https:/www.fractalaudio.com/vp4-edit

VP4-EDIT

Fractal-Bot

In the Tools menu of VP4-Edit, you'll find Fractal-Bot, a companion utility
designed for updating firmware and managing backups of the presets and
settings on your VP4. Fractal-Bot is straightforward to use, featuring a self-
guided, step-by-step interface that makes the process simple and efficient.

Backing up your VP4 is simple with Fractal-Bot's Receive Mode. Just choose a
folder to store your files, press Begin, and click OK.

When a new firmware update is available, open VP4-Edit, launch Fractal-
Bot from the Tools menu, switch to Send Mode, and follow the on-screen
instructions. It's a good practice to make a backup before any update or
whenever you make significant changes to your sounds or settings.

Fractal-Bot even has a built-in help video.



https://www.fractalaudio.com/vp4-edit
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Setup: Classic Pedalboard

» Connect your guitar to VP4 Input L/Mono

Most players will use the VP4 as a straightforward VIRTUAL PEDALBOARD. For » Connect VP4 Qutput L/Mono to your amp.
this setup, connect your guitar to the VP4 L/Mono input. Connect VP4 L/Mono Use VP4 OQutput R to a second amp for stereo.
output to the input of your amp or modeler. Use standard guitar patch cables. » If connecting in front of a modeler, disable its Noise Gate, if possible.

Aside from the usual steps of checking levels and mono/stereo, no special
settings are required.Try banks A-O with this setup.

Use the provided 9V DC 1.3A
VP 4 AC adapter, not shown.

INSTR INPUT

S FRACTAL AUDIO SYSTEMS

INPUTS DUTPUTS PEDAL

8o 0000 ¥ || mmmmm— s s

—
T
: JU W WLy 5585
= ~WA . €L m'COmBO O oo
OP© ® 0 o

OUTPUT | ! OUTPUT ~: To optional to e I
L/MONO | : R Y 2nd amp for stereo P ® ©

AMP OR MODELER

S_e_tup_-Ml_th_o_th_e_r_Ee_d.al_s— » Connect your guitar or the output of another pedal to VP4 Input L/Mono.
»

The VP4 can also be used before and/or after other pedals. Use standard For stereo input, conn.ect both VP4 mPUtS‘ L/M"ono and R and
. : . , be sure SETUP > Audio > Input Mode is set to “STEREQ".
guitar patch cables for every connection. Aside from the usual simple steps of .
checking levels and mono/stereo settings, no special settings are required. > Connect VP4 Output L/Mono to the input of your next pedal or amp.
For stereo input, connect both VP4 outputs, L/Mono and R, and

Try Factory Preset banks Try banks A-O with this setup. If you have a Drive be sure SETUP > Audio > Output Mode is st to “STEREQ”.

Pedal in front of the VP4, try banks P-R or any preset marked ">"

GUITAR

INPUT {_m_-ﬁ-:' OUTPUT rO_UTI._R" Use the provided 9V DC 1.3A
PEDAL(S) L/MONO | ror Sterec/) ‘ L/MONO \ For Stereo to VP4 AC adapter, not shown. PEDAL(S)

from Pedals Amps/Pedals

[rm Y =]mn| ED #~|[RACTAL AUDIO SYSTEMS
(5 m

\ INPUTS ' OUTPUTS PEDAL ,
/a\ A\ \ usg w o
, =) @O @,Oo-..

| L |
DRIVE ME
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The VP4 can be used in an amp’s effects loop for “Post FX".

Aside from the usual steps of checking levels and mono/stereo, no special settings

are required. Use standard guitar patch cables for every connection.

4
4

Connect your guitar to the guitar input of your amp.

Connect the FX SEND of your amp to VP4 Input L/Mono.
Adjust the loop level to prevent clipping on the VP4.

Connect VP4 Output L/Mono to the FX RETURN of your amp.

Use optional Output R to connect to the FX Return of a second amp for stereo.

The VP4 can also be used before, after, or between other “Post” FX in your

amp’s FX loop—in mono or stereo (see VP4 with Other Pedals, previous page).

FAQ: Series Loop vs. Parallel Loop?

While parallel loops were once popular because of how they preserve the
dry tone when used with vintage or less advanced effects, the VP4 and
other modern processors are able to offers excellent sonic performance in
a series loop.

In fact, designing and dialing in sounds for a series loop is easier and more
flexible because the effects chain acts as a single processing path. Not
only does this allow you to use effects that process the dry signal, such as
EQ, compression, volume, etc., but each effect can also process the full
signal from the previous one, leading to unique interactions and a more
complex final sound. Trem-flanged-shimmer-echoes? Easy!

If your amp'’s effects loop is parallel, you must instead ensure that no dry
signal passes through the VP4. This means usually means using only time-
based effects with MIX set to 100% or “Kill Dry” turned on, and “Routing”
set to “Parallel”. (Find these options in HOME > Preset Mix/Routing)

If your amp is switchable, the “Series” loop setting is easier to use and may
be the better choice.

SETTING UP YOUR RIG

Setup: Effects LoopofanAmp

S FRACTAL AUDIO SYSTEMS

INPUTS OUTPUTS PEDAL ™

VP4 /Mono L/Mono MIDI  POWER

OO ®©e=t50

{ OUTPUT"
R

INPUT
L/MONO

! Optional to a 2nd amp for stereo

( FXSEND | (FXRETURN|
, X X
ANP rimplier
(80 0000TS ¢ )
\ )

Presets designed specifically for FX Loop "Post" setups can be found in
banks P, Q, and R. However, some of the presets intended for "Pre" setups
will also potentially work in this type of rig. These have the symbol ">" at
the end of their name.

Bank R contains a preset template for amps with a parallel FX loop. For
such rigs, be sure to follow the instructions in the box at left.
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& FRACTAL AUDIO SYSTEMS
INPUTS 0UTPUTS PEDAL w
[/Mono R [/Mono R DI VP4

\ / use w
/ \

- 0 @
INL ouTL INR
HPre" HPre" llPost"

Four Cable Method, or "4CM," allows you to run two separate mono signal paths through
the VP4: one between your guitar and amp for "PRE" effects like wah or drive, and a second
through your amp's FX loop for "POST" effects like delay and reverb, which can sound
clearer and more defined in this position. For more about pre and post effects, see p. p. 19.
Factory preset bank T is ready to use with 4CM setups.

SPECIAL SETTINGS AND PRESETS REQUIRED!

Q The VP4 requires both a specific global setting and custom presets Use standard guitar patch cables for each @:ﬂ] @Inl]

to function properly with 4CM. Using default settings or presets may connection. Always connect all four cables 52 0000050
cause to your amp to create loud feedback. whenusing 4CMor itwon'twork. N |
Before setting up 4CM, open SETUP > Global Settings > 4CM Routing and set it to > Turm vour amp off and all the way down INPUT
ENABLED. Only presets configured specifically for 4CM will work with this setup. y P . y ) it
Using a preset that IS NOT configured for 4CM will switch the VP4 to BYPASS > Change SETUP > Global Settings >
and defeat all processing. If global 4CM Routing is DISABLED, any preset that IS 4CM Routing to "ENABLED
configured for 4CM will switch the VP4 to ANALOG BYPASS. » Connect your guitar to VP4 Input L/Mono.
» Connect VP4 Output L/Mono to If your modeler has the ability to
the main input of your amp. simulate both an amp's front input
» Connect the FX Send of your amp to VP4 Input R.  @nd a send/return loop, you can use it

in a 4CM setup. However, connecting
» Press HOME and then Page Right 4 times to the Mix/Routing page. > Connect VP4 Output R to the FX the VP4 as only PRE or POST is

. o RETURN of your amp. typically a better option.
» Turn SELECT counterclockwise to highlight "4CM Mode." ! P ypieaty apeteroption

_ » Load or create a 4CM preset (instructions, left).
» Turn Knob A to select the preferred configuration of Pre and Post effects > Turn your amp on and turn up gradually to test.
(options range from 0 Pre / 4 Post to 4 Pre / 0 Post).

When a oreset is confiqured for 4CM. this is shown in the » Remember to turn off your amp or re-wire your rig FIRST if you want to change the
title barr;f the home pgge (Ex: "4CM'2/2" ) This note turns 4CM Routing setting back to DISABLED or use "Reset System Parameters".
orange when the VP4 is bypassed because of a mismatch See the previous page for notes on Series vs. Parallel FX Loops.

between the global and preset 4CM settings.

PRE SIDE — — POST SIDE —
» Save the preset to store your 4CM setting. 780\ N/ 74\
y @GATE }-{ PRE FX IF ANY @ POST FX IF ANY J{ LEVELS/EQ @

4CM IS MONO ONLY N

When using the VP4 with 4CM, keep in mind that it is mono only. Global settings for Input Mode and Output Mode (except "MUTE") are IGNORED when 4CM Routing is set to
ENABLED, and only the left channel of the last Pre- or Post effects is passed to the respective output. As explained in Mono vs. Stereo on p. 11, this means you will only hear half
of stereo effects like ping-pong delay or panning. Mono effect types and settings are therefore recommended for a 4CM rig. Remember also that many stereo effects have controls
like Stereo Spread or Master Pan, which can be used to eliminate differences between right and left channels. Expert Edit options (p. 25) may allow greater control in this area.

In a 4CM preset, the Input Gate is applied at the Pre input, which also feeds the tuner. The master Preset EQ, Main Levels, and Scene Levels are applied at the Post output.
The Input Pad setting (p. 45) affects both the PRE and POST inputs. If your Amp's send level is particularly hot, this might require a higher pad setting than your guitar.
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: +
VP4: PRE-FX

The VP4 can be used just like traditional pedals in
front of an FM3 or other amp modeler. The setups
on this page also apply to the Fractal Audio Axe-Fx,
FM9, and legacy products like the AX8.

» Follow the instructions at the top of p. 17
to connect the VP4 in front of the FM3.

» Connect the FM3 as usual to your
monitors, FRFR, or amp.

BENEFITS: This setup gives you a flexible virtual
pedalboard in front of the FM3. This allows you to
offload CPU hungry “Pre-FX” like Drives. Meanwhile,
using a “Whammy” or “Virtual Capo” on the VP4
leaves the FM3 pitch block free for other things.
The VP4 has the same input gate and impedance
features as the FM3 so you're not sacrificing
anything in this regard.

@ annsrz@

(GIYZES) MARKII-AMP MODELER /FX PROCESSOR

oO0oocd
" L
O

zzzzzzzzz

Factory banks A-0 are well suited for use in
front of a modeler like the FM3.

SETTING UP YOUR RIG

)
\P4: POST-FX_ANALDG

The VP4 can be used after the FM3 for post effects.

» Connect FM3 outputs to VP4 inputs
using cables that end in standard
1/4" connectors (not TRS).

» When connecting in stereo, use two cables
and change VP4 SETUP>Audio>Input
Mode to “STEREQ".

» For FM3 Qut 2, use the Out 2 block in your
FM3 presets, or change SETUP>1/0>Audio>
Output 2 Copy to “OUTPUT 1".

BENEFITS: This setup gives you a lot of power
for effects after the FM3. It also adds additional
instances of effects in cases where the FM3 only
offers one per preset (Pitch, Plex, Reverb, etc.).

VP4: POST-FX, DIGITAL

The FM3 and many other modelers have SPDIF
digital outputs. Remember that the VP4 has a fixed
clock rate of 48KHz.

» For FM3 Out 1 digital, connect a SPDIF cable
from FM3 SPDIF OUT to VP4 SPDIF IN.
o Onthe FM3, set SETUP>1/0>Audio> SPDIF Out
Source to “OUTPUT 1".

o On the VP4, set SETUP>Audio>Input Source to
“DIGITAL". SPDIF is always stereo regardless of
the setting for VP4 SETUP>Audio>Input Mode.

» Connect the output(s) of the VP4 to your
monitors/speakers using standard guitar cables.

BENEFITS: SPDIF digital interconnection creates a
unified rig without the latency of extra conversions.

w Use ONE Noise Gate

When using the VP4 with a modeler like the FM3,
you'll typically need a noise gate only on whichever
device your guitar is directly connected to. You
can disable the VP4's gate per preset (p. 29)

or globally lower its threshold by up to -40 dB,
effectively minimizing its impact (p. 50).

FAQ: VP4 + FM3 + MIDI

Any FM3+VP4 rig allows you to use the two units
independently or linked via MIDI. Most users will
likely have the FM3 control the VP4, but it's also

possible to connect in the other direction.

To use the FM3 to switch the VP4, connect the
FM3’s MIDI Out to the VP4’s MIDI In. For simple
Program Change (PC) messages, set the FM3's
SETUP > MIDI/Remote > General > Send MIDI PC
to the channel your VP4 uses under SETUP > MIDI/
Remote. For more complex messaging, use the
Scene MIDI Block in your FM3 presets.

To use the VP4 to switch the FM3, connect the
VP4's MIDI Out to the FM3'’s MIDI In. Although the
VP4 has more limited outbound MIDI capabilities, it
can send Program Change. To do this, set the VP4's
SETUP > MIDI/Remote > Send MIDI PC to match
the channel that your FM3 is set to under SETUP >
MIDI/Remote > General.

Factory banks P-R, and any preset marked ">"
are well suited for use in post-modeller setups.



& VP4 OWNER’S MANUAL

You can use the VP4 as an analog stereo insert with the FM3, utilizing Out 2
and In 2 on the FM3 to integrate the VP4 into custom presets. This allows you
the flexibility to decide between Pre or Post for each individual FM3 preset,

taking advantage of all the potential benefits outlined on the previous page.
Connect your guitar to Instr In on the FM3.

» Connect FM3 Out 2 L+R to VP4 In L+R using guitar patch cables.
Humbuster™ Cables may be used to combat ground hum which
may occur while a computer is connected to the VP4 via USB.

» Connect VP4 Outputs L+R to FM3 Input 2 L+R using guitar patch cables.

» Connect FM3 Out 1 L+R to your speakers, monitors,
mixer, or other devices as you normally would.

» Onthe VP4, open SETUP > Audio and set Input Mode to “STEREQ”,
Input Source to “ANALOG" and Output Mode to “STEREQ".

» Onthe FM3, open SETUP > 10 > Audio and set Input 1 Source
to “ANALOG”, Input 2 Mode to “STEREQ”, Output 2 Output
Type to “LINE LEVEL", Output 2 Mode to “STEREQ”, Output
2 Level to “+4 dbU” and Output 2 Copy to “NONE".

» Set VP4 Input Pad to 0 dB. Set the FM3 Out 2 Level knob
to 12 o'clock. Set FM3 Out 1 as you usually would.

» Onthe FM3, place the OUT 2 and IN 2 blocks where you want to insert
the VP4. Position them anywhere in the preset, depending on whether you
want the VP4 before (“pre”) or after (“post”) your amp/cab. Ensure they're
connected to each other, and that the preset ends with the OUT 1 block.

» Onthe VP4, you'll probably want to disable the
Noise Gate in your presets (p. 29).

» Bypassing the IN2 block on the FM3 will remove the VP4 from
the signal path, continuing to pass audio without it.

SETTING UP YOUR RIG

FM3 signal path showing the OUT 2 and IN 2 blocks positioned for POST FX (top) and
PRE FX (bottom). You could also place additional FM3 blocks before or after the insert.

FRFR, Monitors
Mixer, etc.
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Factory banks A-0 are well suited fo
in front of an amp block or modeler.

ruse

Factory banks P-R, and any preset marked ">"
are well suited for use after an amp block or modeler.
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Pre vs. Post Effects

SETTING UP YOUR RIG

A guitar amp consists of two main sections: the preamp and the power amp.
The preamp shapes the initial tone, adding gain and often distortion to your
tone. The power amp then amplifies this signal to power your speakers,
making it louder. Some amps also rely on power amp distortion and other
adjustments that further shape your tone.

The placement of effects before or after distortion significantly impacts your
overall tone. This principle also applies to the order of distortion pedals and
other effects. While there are common practices, experimenting with effect
placement can lead to unique sounds. Understanding why certain effects
are typically placed PRE or POST and how this shapes your tone will help you
achieve the sounds you're looking for.

PRE Effects (Before Distortion/Preamp)

Effects like overdrive, distortion, wah, compression, and others are classically
placed before the preamp. This allows them to directly shape the guitar’s raw
signal and drive the amp, affecting tone, distortion, and dynamics.

Try a simple experiment with a Wah effect, a Drive effect, and a clean amp.
When you place the wah in front of distortion, it results in the traditional
"wah-enhanced" distorted tone, where the wah excites certain frequencies

as you sweep it (and who doesn't love a parked wah tone?!). Placing the wah
after the distortion, however, has a profound impact, peaking and cutting the
rich harmonics generated by the distortion. This can result in a synth-like
sound, which makes sense since many synthesizers place filters (akin to wah)
after harmonically rich oscillators.You can try this same experiment with EQ,
phaser, and other effects in relation to distortion.

TIP: VP4-Edit allows you to drag and drop one effect on another to swap them!

POST Effects (After Distortion/Preamp)

"Time-based" effects such as reverb, delay, and chorus are often placed after
distortion. This allows the repeats, ambience, or subtle modulation to be
heard clearly and distinctly—instead of being "trashed" by further distortion.
If you tried the experiment earlier in this section, you know that EQ, phaser,
and other effects can also be used after distortion to produce sounds with a
very specific character. Meanwhile, a rotary effect would sound familiar after
distortion, since it simulates the movement of a physical speaker.

Exceptions and Special Cases

The first exception is the big one. Creativity does not play by the rules. In fact,
any effect can in fact be placed in any position. For example, echo or delay
into a cranked amp or drive pedal was part of "the sound of the 70s" and is
still widely used today in many styles of music. Artists like The Edge, Neil
Young, Eric Johnson, and Jimmy Page have all utilized this technique, and
they created some of the most iconic tones in history. Even distortion itself
can be an outlier. In metal, industrial, punk, and other styles, distortion can be
used in unconventional ways to achieve aggressive saturation and lofi effects.

EQs and effects that sculpt tone — including phasers, flangers, filters, and
more—create different but useful and interesting sounds either before or after
distortion. Try it and see!

Pitch effects are also a special case. "Heavy" consonant harmonies like 5ths
and octaves can be epic when run into distortion. Shifters that are 100%

wet like the Whammy or Virtual Capo can sound more natural when they are
processed by drive effects and your preamp, but can hint at "chipmunk" or
"ogre" in post. Complex or dissonant harmonies, as well as subtle detune

and shimmer effects, can get "clobbered” by distortion—just like delays and
reverbs—so they are often used post. Shimmer and other harmony effects can
also create high or low frequencies, meaning they interact differently before
or not only distortion but EQ, filter, etc. (Ring modulators can fall into this
category as well.) Again, experiment and see what you like.

Summary

PRE EFFECTS shape the fundamental tone and dynamics of the guitar signal
before it's amplified or distorted. They can also be used to push your preamp,
changing its tone, distortion, and dynamics.

POST EFFECTS can add ambience, depth, and modulation to the already
shaped or distorted signal without compromising clarity. They can also have
a more profound effect on distortion by changing its tone in dramatic and
noticeable ways.

ALL EFFECTS can be placed where you think they sound best. You can learn
more about the creative use of effects by studying the rigs of your guitar
heroes, by experimenting with the VP4 and your other equipment, and by
learning more about audio, acoustics, physics, sound design, and music.
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Each preset is like a virtual pedalboard with your choice of four effects,
effectively allowing one VP4 to replace an entire collection of traditional
pedals. Additionally, each preset has its own Noise Gate, Master EQ/levels,
and more.

Just as you can have multiple physical pedalboards, you can create multiple
presets. In each preset, you can start fresh (or from a copy) and save your
configuration. Every preset in the VP4 can be customized or even erased.

Some players may rely on just a single preset, while others might create
different presets for each gig or even for different parts of one song.

PRESET BANKS

The VP4 organizes its presets into 26 banks, each identified by a letter from
A to Z. Within each bank, there are four presets, numbered 1 through 4. For
example, the presets in the first bank are labeled A1, A2, A3, and A4.

LOAD PRESETS INPRESETMODE

» InPreset Mode, tap the footswitches to select one of the
four presets in the current bank (e.g., A1-A4).

» To change the BANK in Preset Mode using the footswitches, press
and hold Switch 4 or Switch 1 to step up or down through the banks.

~ TAP any switch to load a Preset from the current Bank.
1 2 3 4y
SHOLD 1: SHOLD 4:
Previous Bank Next Bank

» Onthe Home page in Preset Mode, you can also turn Knob
A to browse the entire list of presets on the VP4. Press
ENTER to load the selected entry or EXIT to cancel.

o The footswitches will automatically update to reflect the selected preset
and bank. For example, if you load preset A1, the footswitches will map to
all four presets in bank A, so, A1, A2, A3, and A4. If you load preset Z4, the
footswitches will be Z1, 72, 73, and Z4.

PRESETS

FACTORY PRESETS

The VP4 comes preloaded with dozens of factory presets. A directory at the
end of this manual lists them with notes. Please note that different types of
rigs work best with certain types of effects. Presets are arranged categorically
to make this easier:

Banks A-0 : “Pre-FX” (pedalboard) presets for use between guitar and amp

Banks P-R: “Post-FX” presets designed for amp FX loop (series)
Bank S : Bass presets, plus an Acoustic guitar template.

Bank T : “ACM" presets.

Banks V-Z : Blank presets for you to store your own creations.

Remember, you can modify or overwrite any factory preset. Should you desire,
you can download the current factory presets from:

https://www.fractalaudio.com/vp4-downloads


https://www.fractalaudio.com/vp4-downloads
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Factory Presets

Notes about the factory presets can be found in the table on p. 58.

Most presets in the VP4 are designed to be used in front of an amp. These are
compatible with other effects placed before or after the VP4.

Presets designed for FX Loop "Post" applications can be found in banks P,
Q, and R. These also work very well in a "Pre" setup if the amp is clean or if a
drive pedal is placed in front of the VP4. Similarly, many of the "Pre" presets
can also work in a post rig. These are marked ">".

Bank R contains a preset template for amps with a parallel FX loop.
Bank S contains presets for bass guitar and acoustic guitar.

Bank T contains several examples designed for 4CM rigs (see p. 19).These
presets will be automatically Bypassed if your VP4 has default settings.
Similarly, presets not configured for 4CM will be bypassed if the global 4CM
routing option is enabled.

NOTE: The VP4 is unlike most other Fractal Audio products. Without amp and
cab modeling, it is designed to be used with an amp or a modeler. Therefore,
the way the factory presets respond can be quite different from one setup to
the next. Keep this in mind:

1) Some amps can get loud when used with certain effects or settings. Adjust
and save to set levels as needed for your equipment.

2) The best results will probably also require custom settings for your guitars,
amps, speakers, and other effects. The VP4 is easy to use. Make it your own.
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Working With Effects
In the real world, building a pedalboard means making hard choices about
valuable “real estate.” With the VP4, however, such limitations are replaced by

a vast “inventory” of virtual effects. To design a preset, you select effects, dial
in basic settings, and save.

TURNING EFFECTSONANDOFF

» Change to EFFECTS MODE and use the footswitches.

CHOOSE EFFECTS

» Onthe Home page, turn SELECT to highlight any effect or empty slot.

» Turn the corresponding ABCD to set the Block Type. (Ex: “Drive” or “Reverb”).

o To remove an effect, choose “No Effect” from the list.
» Press ENTER to confirm or EXIT to cancel.

EDIT EFFECT SETTINGS

» Onthe Home page, turn SELECT to highlight any effect.

Press ENTER to show the effect editor.

Use the ABCD knobs to adjust settings. Turn SELECT to change rows.
Use PAGE buttons for effects with more options.

To change the Effect Type at any time, just tap page left
until the Type Picker appears (see FAQ, top right).

» Press EXIT or HOME when finished.

v v Vv Vv

Gear Nerd? Expert Tweaker? 5 05 = @

The VP4 was designed for ease of use, offering minimal

options similar to traditional pedals. At the same time, Fractal Audio is known for
its extensive depth and flexibility, allowing creative players and FX enthusiasts to
dive deep into sound design.

If that sounds like you, then Expert Edit may be of interest. This special mode
reveals expanded options for editing effects and modifiers. To open Expert Edit,
press PAGE LEFT and PAGE RIGHT at the same time while editing an effect, or with
an effect selected on the home page. Press EXIT at any time to quit Expert Edit.

PRESETS

FAQ: Block Type vs. Effect Type

Effects on the VP4 are organized as “blocks” in high level categories like

n u

“Drive,” “Delay,” or “Reverb.” Each block also contains an Effect Type picker.
For instance, within the Drive block type, you can choose from effect types

nu

like “Face Fuzz,

* BB Pre

* BB Pre AT

* Bender Fuzz

* Bit Crusher

+ Blackglass 7K

* Blues OD

* Bosom Boost

* Box o' Crunch

+ Compulsion Distortion
+ DS1 Distortion

+ DS1 Distortion Mod
+ Esoteric ACB

+ Esoteric Bass RCB
* Esoteric RCB

+ Eternal Love

* Face Fuzz

* FAS Boost

* FAS LED-Drive

« Fat Rat

* FET Boost

* FET Preamp

nou

Klone Chiron,” “Super Overdrive,” and many more.

Block Types available on the VP4 (above)
vs. Effect Types in the Drive block, for example (below).

* Full OD

+ Gauss Drive

* Griddle Cake

* Hard Fuzz

* Heartpedal 11

* Hoodoo Drive

* Horizon Precision Drive
+ Jam Ray

* Klone Chiron

* M-Zone Distortion
*» Master Fuzz

+ Maxoff 808

* MCMLXXXI Drive
* Micro Boost

* Mid Boost

* Nobelium OVD-1

+ Octave Distortion
+ 0D 250

+ 0D 250 Gray

+ 0D-One Overdrive
* Pl Fuzz

* Plus Distortion

* Rat Distortion

* SDD Preamp

+ Shimmer Drive

+ Shred Distortion

* Sonic Drive

* Suhr Riot

* Sunrise Splendor
* Super 0D

* T808 Mod

+ T808 OD

+ Tape Distortion

+ Timothy

« Tone of Kings

* Treble Boost

* TS9DX +

* TS9DX Hot

* Tube Drive 3-Knob
* Tube Drive 4-Knob
+ Valve Screamer VS9
* Zen Master
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Blocks Guide

Effect Blocks Inventory

The table below lists all the Blocks available on the VP4, showing the number
of Types available for each block and the maximum number of each block that
can be used within a single preset.

Block Description Types #
CHO Chorus Classic mono and stereo modulation effects including vibrato. 20 4
CMP Compressor Control dynamics and add sustain. 16 4
DLY Delay Up to 8 seconds of delay, with types for analog, digital, tape, and more. 28 4
DRV Drive Types include overdrive, distortion, fuzz, boost, and many more. 63 4
ENH Enhancer Classic and modern spatialization. 3 4
FLT Filter Includes classic and esoteric filter types plus touch-wah and auto-wah. 18 4
FLG Flanger Types cover everything from subtle mod to “zero cross” to extreme jet. 32 4
FOR Formant Create dynamic vowel sounds and talk effects. 1 4
GTE  Gate/Expander  Use thisin addition to the built-in preset gate for creative effects. 4 4
GEQ Graphic EQ Multiple types ranging from three bands to ten. 16 4
MGT Megatap Creates echo patterns with controls that shape time, volume, pan and more. 20 4
MTD v Fantastic collection of multi-tap delays, choruses, and more. 34+ 4
PEQ Parametric EQ The 5-band parametric equalizer allows precise control of your tone. 1 4
PHR Phaser A variety of vintage and cutting edge phaser effects, including ‘vibe. 16 4
PIT Pitch Shift Includes capo, detune, harmonizer (intelligent/custom), whammy, and more. 16 2
PLX Plex Delay Up to eight delays and pitch in a matrix. From granular to lush... Gorgeous! 44 4
RES Resonator Resonant filters create ringing tones, chords and more. 1 4
REV  Reverb World-class recreations of vintage springs, rooms, plates, halls, and more. 66+ 2
RNG Ring Mod The extremely flexible ring modulator provides for a range of cool effects. 1 2
ROT Rotary Simulates a classic rotary speaker with multiple microphones. 1 4
SYN  Synth A 3-voice monophonic synth that tracks what you play. 1 2
TRM Tremolo Essential vintage and modern tremolo styles, plus auto pan. 5 4
VOL Volume/Pan Simple volume block also offers channel input/output tools. 1 4
WAH Wah The essential wah, with multiple types based on classic originals. 8 4

A VP4 Basic Blocks Guide is in progress. It details
the effect blocks, types, and basic parameters.

Meanwhile, since the VP4 is based on the award-
winning Axe-Fx lll, the Fractal Audio Axe-Fx Ill/FM9/
FM3 Blocks Guide provides a detailed reference
that is equally applicable to almost every basic and
expert of the VP4 effects.

The Fractal Audio Blocks Guide can be downloaded

from https:/www.fractalaudio.com/fas-hg

Note for Axe-Fx III, FM9, and FM3 Users

To enhance the standalone VP4 experience for new users, the
® names of some parameters on its “Basic” pages may differ

from those on its “Expert Edit” pages (p. 25) and therefore
from their equivalents on the Axe-Fx, FM9, or FM3. For example, “LFO
Depth” might appear simply as “Depth,” and “Diffusion Mix” might be
labeled just as “Diffusion.” Since many pedals use minimalist or creative
labels, we wanted the VP4 to feel more intuitive for those accustomed to
this style.

Additionally, the VP4 includes various new effect types not found in our
other products. These are essentially tweaks of existing types, presented
with simplified interfaces. Examples include "Vibrato" types in the Chorus
block, single-voice types in the Pitch block, changes and consolidation in
Plex block types.

Some blocks include other types of differences. The "Mix law" on most
time based effects has been sweetened for use in front of an amp. The
VP4 Drive block uses a switchable control "Mode" switch instead of
separate types for some pedals (e.g. Compulsion Distortion HP/LP).
Also, for ease of use and greater preset portability, the "Custom Shifter"
utilizes local custom scale settings instead of global ones.

Other differences are merely superficial, such as renaming Reverb types
for better alphabetical ordering.


https://www.fractalaudio.com/fas-bg
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In a DSP-based processor like the VP4, the CPU acts as the brain, managing
and executing all the effects, settings, and functions. The CPU Level

indicates how much processing power is being used. The VP4 has a powerful
processor, able to run top quality effects in impressive combinations.

A meter in the upper right shows the current CPU level, with a normal limit of
about 80% to keep some required processing power in reserve. If this limit is
exceeded, the VP4 will switch to bypass mode and display a warning: “CPU
LIMIT: Bypassed.”

CPU usage depends on the number of effects in a preset, their settings,
modifiers, and more. Even an empty preset consumes some CPU. As you add
effects or use more demanding settings, the CPU level rises.

CPU TIPS

» Bypassed blocks still use CPU to stay ready for instant activation.
To save CPU, remove any blocks you aren't using.

» Modifiers use a small amount of CPU, and their Update
Rate setting can impact this usage.

» If you need multiple types of an effect, for example, Drive: Treble Boost
vs. Drive: Fat Rat, but don’t need them both to be active at the same time,
you can use one block with different Channels instead of two separate
blocks, saving considerable CPU. Learn more about Channels on p. 34

» Different Effect Types (p. 25) within a block can use varying amounts of CPU.
For example, in the Plex Delay block, the “Golden Shimmer” uses around 18% CPU,
while the “Econo Shimmer” uses about 11%. In the Reverb, “Spring” types use less
CPU. Experiment with changing types to see which are more or less CPU-hungry.

» There's also significant variation in CPU usage among Drive block types.
Consider options like Shimmer Drive or FET Boost if you need a low-
CPU drive. For a totally clean boost, consider an EQ or a Filter!

» Take advantage of gapless switching! If you don't need all effects
active at once, use different effects in different presets and switch
between them smoothly. Note that ensuring spillover between different
presets requires special attention. See p. 32 for details.

» Effect settings can also impact CPU usage. For example, lowering the
“Quality” setting in the Reverb block can help save CPU resources.

» Expert Edit (p. 25) offers access to additional parameters
that can further lower CPU usage for an effect. Visit our forum
to talk with Fractal Audio experts and discover more tips.

&almg_cl 1anges
If you edit a preset and want the changes to be retained for future use, you
must SAVE. Unsaved changes will be lost when you switch to a different

preset or power off the device. Every preset in the VP4 can be saved or even
overwritten.

To save a preset, press the SAVE button. From here, you can press ENTER
followed by ENTER to confirm, or take a moment to edit the preset name or
scene names before saving.

When you edit any preset in any way, the front panel “EDITED” indicator lights
up until you save or load a new preset. It appears in the title bar as a yellow
dot with an “E" .(®

NOTE: Editing a preset includes: changing effect settings, turning effects
on or off, adjusting Input Gate/Main Levels/Preset EQ, changing the Scene,
changing the tempo, or editing controllers.

Changes made in the SETUP menu always saved automatically.

TO SAVE A PRESET

» Press SAVE to show the Save page.

» Press ENTER to Save. You'll be prompted to press ENTER again to confirm.
» The message “SAVED!” is shown when saving is complete.

TO CHANGE PRESET OR SCENENAMES

You can edit the name of any preset or its scenes while saving.

» Press SAVE to show the Save page.
» Select the NAME fields to edit the preset name any of the Scene Names.
o Turn the knob A to move the cursor.
o Knob B selects UPPER CASE letters and space
o Knob C selects lower case letters and space.
o Knob D selects numbers and symbols and space
o Page Left = DELETE character. Page Right = INSERT character.
o You can use up to 31 characters in a preset name.
» Press ENTER to Store, then press ENTER again to confirm.
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Preset Tutorial

Load an Empty Preset Add Delay and Reverb.
» Change to Preset Mode » Use what you've learned to add a Delay block and
» Turn knob A to any <Empty> preset and press ENTER. a Reverb Block for effects 3 and 4.

Add a Phaser effect » Save the preset when you're done.
» Turn SELECT until the first effect is highlighted. You have now created a preset from scratch!
» Turn A until the Phaser effect is shown and then press ENTER. For those who wish to dive deeper into some of the more advanced
» Press ENTER again to edit the Phaser. The Phaser Types page will appear. functionality offered by just a single VP4 preset, this tutorial continues on
» Turn knob A to highlight the “Script 90" type. p. 37 with Channels and Scenes.

» Press ENTER or Page Right to show the settings for the Phaser.

» We'll start simple. Adjust Rate and Depth however you like them.

» Press EXIT when you're done.

Save the Preset

»

Press SAVE.

We're not going to change the LOCATION where the preset is saved but we
are going to give it a NAME. Turn SELECT to highlight the NAME line.
Use: Cursor (knob A) A-Z, (knob B) a-z (knob C) 0-9 (knob D)

Enter the name “My VP4". If you make a mistake, PAGE LEFT
and PAGE RIGHT can be used to delete or insert characters.

Press ENTER twice to commit your changes.

Add a Drive effect

v Vv Vv Vv Vv Vv

Turn SELECT until the second effect is highlighted.

Turn knob B until the Drive effect is shown and then press ENTER.
Press ENTER again to edit the Drive. The Types page will appear.
Turn SELECT or knob A to highlight the “T808 OD” type.

Press ENTER or PAGE RIGHT to show the settings for the Drive.

Dial in the Drive however you like it and press EXIT when you're done.

Save the Preset Again

»

Press SAVE, ENTER, ENTER.
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Noise Gate

PRESETS

Every preset includes an adjustable noise gate at the input, before any effects.

The noise gate can be used to eliminate unwanted noise and hum by cutting
off or filtering the sound when its level drops below a certain threshold.
This is especially useful when using high-gain amps or playing in noisy
environments.

The gate has the following controls:

Gate Type - The “CLASSIC" type opens and closes like a typical gate pedal.
The “INTELLIGENT” and “NOISE REDUCER" types use precision filtering to
minimize noise from electromagnetic interference (“EMI"). For these gates
to work effectively, it is crucial to set SETUP > Global Settings > AC Line
Frequency based on your location. The default setting of “60 Hz" is suitable
for North America and most of Central and South America. The “50 Hz"
setting is for Europe, Asia, Africa, Australia/New Zealand, and parts of South
America such as Argentina and Chile.

Threshold - This determines how quiet the signal must be for the gate to
close. Higher settings make the gate more aggressive, meaning it will close
on louder signals. To turn the gate completely off, set this control fully
counterclockwise.

Release - The Release setting determines how long it takes for the noise
gate to close after the signal level drops below the threshold, which typically
happens when you stop playing. Choose a high setting if you want the gate to
drift closed, allowing the noise to fade out over up to 1 second. Choose a low
setting if you want the gate to snap shut abruptly.

Level - This adjusts the level of the signal coming out of the gate if you
need a boosted level going into your effects. However, be aware that this
compromises unity gain.

INPUT GATE EXPERT SETTINGS {5 - &€

The Noise Gate contains several “hidden” expert parameters. These will be familiar
to those who use current Fractal Audio products, or those who like to dive deeper
into sound design. While on the Input Gate page, press Page Left and Page Right at
the same time to show its expert settings page:

Ratio - Think of this as the strength of the gate. A higher ratio causes the closed
gate to reduce the noise more dramatically, while the lowest setting (1:1) causes
the gate to have no effect at all.

Attack - This determines how quickly the noise gate opens after the signal level
exceeds the threshold — typically when you start playing. Choose a fast setting for
a quick, aggressive attack. Choose a slow setting if you want the gate to openin a
more relaxed way. The default of 2.0 ms is a good starting point.

INPUT IMPEDANCE (@)

The Input Impedance setting, found alongside Expert settings for the Gate (above)
controls how the VP4 uses real analog components to vary the load on your guitar
pickups. This replicates the tonal changes caused by the impedance of certain
analog stomp boxes (e.qg., vibe, fuzz effects).

In the default “AUTO” mode, the impedance is set automatically based on the first
active effect in your preset. This setting—applied whether or not you ever look at
the Expert page—is usually best, but you can also select custom values if desired.

L]
Main Levels
The Main Levels page of every preset contains the master Preset Level and
Preset Balance controls.

HOME ... PAGE RIGHT 2x

In addition, each Scene also has a Scene Level control which can be used to
trim the level of that scene +/- 20 dB.

Preset EQ

Every preset has its own master 10-band EQ. The EQ setting is applied at the
output. All effects and scenes in the current preset are processed by its EQ
settings.

HOME ... PAGE RIGHT 3x
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PRESETS

The Preset Mix/Routing page is like a “Command Center” for the various mix-
related settings for all effects in the current preset. It shows the four effect
types and allows you to adjust their Mix, Level and other settings without
bouncing between menus. To navigate this page, turn SELECT to the desired
row, and turn ABCD to adjust settings for the four effects.

Bypass - Use this to bypass/engage effects when you're not in Effects Mode.

Mix - This adjusts the balance of “Dry” and “Wet” for the effect. Effects with
no mix, such as Wah, GEQ, etc., will show “NA”.

Level - This adjusts the overall level of the effect, both wet and dry.

Meters - A meter at the top of each column shows the input level (blue) and
output level (green) for the corresponding effect. When clipping occurs,
the meter turns red. This makes the Mix/Routing page an excellent tool for
tracking down the cause of clipping inside a preset. For instance, if you see
that Effect 3 overloads its output but not its input, you know to adjust the
settings inside Effect 3 to correct this.

Bypass Mode - Bypass Mode determines how an effect block behaves when it
is bypassed. The default setting of “Mute FX In” for time-based effects allows
tails to spill over when the effect is bypassed. (Note that for these effects,
“Level” controls the dry even while the effect is bypassed.) The default setting
of “Thru” for non time-based effects behaves similarly to “True Bypass” on an
analog pedal: while bypassed, “Thru” has no impact whatsoever on the sound.
(Additional options for Bypass Mode are covered on the next page.)

Kill Dry - Kill dry is a provided for those who run time-based effects in parallel
(see “Routing” below). With Kill Dry turned on, no DRY signal passes through
the block. Instead, the Mix control functions as a level control for the Wet
signal only, potentially making parallel effects easier to use.

Channel - Changes the Channel of the selected effect. Remember that each
channel has its own settings for all parameters — including Mix, Level, Bypass
Mode, Kill Dry, etc.). You can even change the Effect type — but not the Block
Type). See p. 34 for more on Channels.

TIP: If you're using Scenes, change to Scene Mode and open this page as an
excellent “Scene Builder” with the ability to adjust bypass, channel, mix, level,
and more—with four scenes instantly available across the footswitches.

Routing: This parameter allows effects 2, 3, or 4 to be run in Series or Parallel
with respect to the previous block. A dynamic illustration shows the current
configuration.

Example: Setting Effect 3 to “Parallel” places it in m
parallel with Effect 2, as shown in the image (right). - FX1 H —— HFX4
Of course you could say that Effect 2 is also parallel m

to Effect 3, but on the VP4, “Series” or “Parallel” refers

to the previous block. So, Effect 2 is in series with Effect 1, and Effect 3 is in
parallel with Effect 2. This also explains why you can’t choose “parallel” for
Effect 1: there is no previous effect!

FAQ: Why Do People Use Parallel Effects?

If you, like most people, have always strung pedals together in a chain, you'll be
comfortable with the default settings on the VP4, with four effects in series.

The option to run effects in parallel does create certain creative sound design
opportunities however. An easy example to understand is Reverb and Delay in
series or in parallel. In series, you hear reverb on the dry (what you play) and
the wet (the echo that follows). In parallel, only the dry signal passes into the
reverb, so the echoes that follow are dry, with no reverb.

MYTH: Time-based effects are easier or sound better in parallel.

Q)
FACT: On the VP4, time-based effects work just as well in series as $ %
they do in parallel, with no difference in the dry signal’s level or tone.

First, adjusting Mix for time-based effects on the VP4 does not change the dry level
until it is turned above 50%, making it easy to maintain unity gain.

Second, the VP4 has a very high-quality signal path, meaning that the dry signal isn’t
compromised like it might be on vintage gear, analog pedals, etc.

In short, you can easily achieve excellent results with series effects. If anything, it's
parallel effects that require extra effort, as you'll need to either 1) turn on Kill Dry if
available for that block, or 2) adjust the Mix to 100% and set Bypass Mode to “Mute In”
or “Mute Out.”

built-in “Help” page. To view it, select any Routing parameter on

Because parallel effects require special settings, the VP4 has a
m the Mix Overview page and then press ENTER.
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Bypass Mode , \

MUTE FX OUT - When the block is (L] o +—®
Bypass Mode might be considered an expert feature, as most musicians bypassed, the outputs of the wet/effect
won't need to adjust it often. However, understanding how it works may prove are muted, ending tails immediately. The Effect | |3
useful. bypassed effect continues to process or »Q
You can set Bypass Mode for an effect to determine how it behaves when audio, so tails are already present when \ =
bypassed. Each channel of an effect can have its own Bypass Mode, allowing you turn it back on. The dry signal remains
for different behaviors across channels. While not every block type has this the same whether the effect is on or off.
feature, most do. Note that Level, Balance, and other parameter that affect the Dry signal
You can find Bypass Mode for each effect on the Home > Preset Mix/Routing continue to do so even when the block is bypassed.
page. It's also available in Expert Edit (p. 25) for each effect.
?
(@ e o rememers ete s ese | i - en ok s s, 1o
i - i its inputs are muted. This silences both g
, . , . ) wet and dry signal but allows effect Effect | =
The default setting of “Mute FX In” for time-based effects allows spillover tails to spillover. Use this mode when | =
of tails when the effect is bypassed. The default setting of “Thru” for non you want tails oﬁ a time-based effect O»¢ VR
time-based effects behaves similarly to “True Bypass” on a pedal — while in parallel and Kill Dry is not on or s g
bypassed, that effect has no impact whatsoever on the sound. available.
Different effects include additional options, detailed here:
MUTE - When the block is bypassed, both wet and dry are totally silenced. MUTE OUT - When the block is o[ %)
bypassed, all audio is totally silenced
THRU - When bypassed, the block is completely disengaged. None of its !‘mmed_latsly, but the_lnput“|s still ) Z
parameters have any effect on the sound. It behaves like an empty effect. listening” so tails will be “pre-loaded
when you engage the effect. Use this 9*\ X)
~ : p < mode when you want no tails on a time-
MUTE FXIN .When the block is . = 0 based effect in parallel and Kill Dry is
bypassed, the inputs to the wet portion of Hot on of available
the effect are muted, effectively turning X = :
off the effect while “tails” ring out or X
“spillover.” The dry signal remains the 0’1—{ ) »Q

same whether the effect is on or off.

Note that Level, Balance and other parameter that affect the Dry signal
continue to do so even when the block is bypassed.
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Spillover

|

Spillover allows delay and reverb tails to “ring out” when an effect is bypassed TRY IT! . _
or when you change scenes or presets. This section covers how to set up » Place a Delay effect in a new preset. Turn up the Mix and
spillover in different scenarios. Feedback, and use a footswitch to bypass the effect. It will

also work if a Scene bypasses the effect for you.
When Bypassing an individual Effect » With Global Spillover set to “ALL", save an exact copy of your preset
For tails that ring out when a block is bypassed, set the block’s Bypass Mode to a new location and test spillover as you change between them. You
(p.31) to “MUTE FX IN”. This is the default setting for most time-based can use this technique as a starting point, making changes in the new
effects. For effects routed in parallel (p. 30), use “MUTE IN” instead. preset without disrupting any of the settings that affect spillover.
When Switching Channels Disabling Spillover
Spillover will continue when you change an effects channel, but be aware You can also apply these techniques to disable spillover.
that different channels use the same memory, so changes to parameters like For example, the Bypass Mode “THRU" or “MUTE FX OUT" can be used to kill
type, time, or size may cause a “sweep” effect in the tail. To ensure perfect the tail instantly when an effect is bypassed.

spillover, use multiple blocks of the same type instead of changing channels. You can also disable the global preset spillover setting by setting it to “OFF".

When Switching Scenes

Since scenes simply bypass or engage blocks, and potentially change their
channels, see the two entries above to ensure perfect spillover.

When Changing Presets

Spillover between presets is more involved. First, go to SETUP > Global
Settings and set the Spillover parameter to determine whether “DELAY,”
“REVERB,” “DELAY & REVERB,” or “ALL" will spill over when switching presets.
("ALL" includes Delay, Reverb, Plex Delay, Multitap Delay, and Megatap blocks.)

You must also ensure the exact same blocks exist in each preset you switch
between. These blocks need to be the same block type and number;
Delay 1 spills over only to Delay 1; Delay 2 to Delay 2, and so on.

The corresponding blocks must also have similar settings and placement. For
example, if you switch from a preset where Delay 1 is a “Digital Mono” delay
with Time 200 ms, to one where Delay 1 is a “Analog Stereo” with Time of 500
ms, the tails and tone will not be consistent across the change. Similarly, you
might hear a difference in the tail if a block is placed before vs. after another
effect across different presets.
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Reset Tools

The Tools menu allows you to reset various parts of the current preset to their
default settings. Use Reset when you need a fresh start after making changes
to an effect block or other area, or as a troubleshooting step.

» Turn A to select a category from the left column.
» Turn C to choose a specific tool (some categories have only one option).
» Press ENTER to execute and confirm.

The four “Reset FX” options include tools for each channel, with the currently
selected channel indicated by a dot. You'll also find tools to reset the Input
Gate, Main Levels/EQ, and the entire Controllers menu.

Note that resetting an effect or channel does not remove any modifiers. To do
that, go to Home > Controllers > Modifiers, open each modifier you want to
remove, and change its Source to “NONE"—or just remove the entire block and
re-insert it into the preset.

Remember to Save a preset after performing any reset(s) if you want the
changes to be permanent.
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Intro to Scenes

Imagine a traditional pedalboard where you might want to turn multiple pedals
on or off quickly to set up different sounds — in other words, tap-dancing.
Scenes in the VP4 simplify sound changes by allowing you to switch between
effect combinations with a single action. Scene even include a way to adjust
the overall output level. Scenes can also change effect Channels (right).

Scenes don't need to be created—they're already there, ready to be set as
desired. To save any changes to a scene, you must save the entire preset.
When you save any preset, you can also give each scene its own name.

SELECT A SCENE

» In Scene Mode, tap a footswitch to select the corresponding scene.
» Onthe Home Page, you can also select the Scene name

+ TAP any switch to load a Scene from the current Preset.

1 4
© (6]
$HOLD 1: ¥ HOLD 4:

Previous Preset Next Preset

and press ENTER to use the Scene Picker.

= MIDI - MIDI can be used to select Scenes using the various
options in the SETUP > MIDI/Remote menu (p. 48).

= VP4-Edit provides an easy, one-click way to change the Scene.

A Keep in mind, Scenes do NOT store individual parameter values. If you
want an effect to have different settings in different scenes, even if
it's just for a single knob, you'll need to switch the effect to a different
channel.
The flip side of this is one of the great benefits of using scenes: any
changes made to a channel will conveniently adjust all other scenes that
use the same channel, making it easy to apply consistent updates across
multiple scenes.

SCENES & CHANNELS

Intro to Channels

With channels on the VP4, each effect block is like entirely different versions
of that effect rolled into one.

Every effect in every preset has four independent channels: A, B, C, and D.
YOu can change the channel manually, or a Scene can change it for you.

While Channels can’t change the Block Type (e.g., DRIVE vs. DELAY), they can
change the Effect Type and all other settings. For example, Channel A of a
Drive could be dialed in as a clean boost, Channel B as a laid back overdrive,
Channel C as a dimed distortion, and Channel D as a spitty fuzz. Every knob or
setting in each channel is independently adjustable!

SELECTACHANNEL

The VP4 offers various ways to select a channel, whether for editing or during a
performance.

» InFX Mode, press and hold the footswitch for any effect to display its
Channel Picker. This requires the default Gig Mode setting (p._6).
o am» —) -

a2\ Ve 3\ =\
o The main display shows the Effect Type for each of the channels.

o Tap a channel switch to select and exit, or press and hold to select and stay.

o Onthe HOME page, this selects the effect. However, while editing, you can
change any effect’s channel without switching away from the one you're editing.

= While Editing an Effect - Page left to the “Type” page and turn Knob D.

= From HOME, page right to the Preset Mix/Routing page.
Once there, turn Select to highlight the “Channel” row and
turn ABCD to set the channels for four effects.

= MIDI - MIDI can be used to change the Channel.
= VP4-Edit provides an easy one-click way to change the channel.

SETTING UP CHANNELS

To set up a Channel, simply select it as described above, change the various
settings, and then save the preset. Note that any MODIFIERS (p. 38) apply
to all channels.
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Workina With Scenes

SETTINGUPSCENES ADJUST SCENE LEVEL

Whenever you create a preset, you are already using at least one Scene. Scenes can also adjust the overall output level. When boosting a scene,
Setting up additional scenes is easy. Here are step-by-step instructions: remember to be on guard against output clipping. If you can't turn up one
> Change to Scene Mode and select the desired Scene. scene loud enough without clipping, turn the others down.

» Change to FX Mode and turn Effects ON or OFF using the footswitches. » Press HOME and then change to Scene Mode first so you can

> Set the CHANNEL for each block as desired (p. 34) use the footswitches to check levels as you change Scenes.

» Test and save your preset, adding names to your scenes as desired. > Press Page Right 2x to the Main Levels page.

See p. 27 for more on Saving Change& » Use SELECT and ABCD to adeSt Scene Levels.

» Save the Preset.
Scenes Example:

THEDEFAULTSCENE
SCENE 1 SCENE 2

When a new preset is loaded, it automatically starts on whichever Scene was
selected when the preset was last saved. To set the default scene for any

CHO REV DRV DLY REV preset, select the desired Scene and then save the preset.
A A B A B

If you'd rather override this behavior, you can change the Default Scene in
SETUP>Global Settings>Default Scene.

In this example, the Chorus and In this scene, the Chorus turns off
Reverb are on, Drive and Reverb Off. | and all the other effects turn on.

Imagining the Drive on channel A as a | The Drive changes to channel B.
Clean Boost, you could manually turn | Imagine that it is a Screamer Drive,
it on or off in FX mode. making this like a “lead” scene.

With four scenes in every preset, you have the flexibility to create a variety of
sounds within a single preset, each tailored to whatever you need it to do.
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Scene FAQ

SCENES & CHANNELS

FAQ: Do I Need to Use Scenes and Channels?

You can enjoy the VP4 without needing to understand Scenes or Channels. Even if
you don't dig in to presets, you can use the FX very much like traditional pedals.

Do recognize, however, that Scenes and Channels are always there whether you
rely on them or not. They're like the gears on a multi-speed bike: you can ride and
never change gears, but they're still there. In the same way, you're always using at
least one scene, and every effect is set to one of its four channels. So technically,
YES, you need to use Scenes and Channels, but you don't really need to know
much about them unless you want to take things to a new level.

FAQ: Why does editing an Effect change every Scene?
It doesn’t have to, but unless you understand and use Channels, it will.

If you want an effect to have a different settings in a different scenes, you'll
need to set it to a different channels.

Whenever you edit an effect block (like Drive, Delay, or Reverb), it's always set
to one of its four Channels (A, B, C, or D). When you change the settings for
that Channel, all Scenes that use that Channel will have those changes, which
is why edits might affect multiple Scenes.

To avoid this, switch the effect block to a different Channel before making
edits. This way, your changes apply only to the Scenes using that Channel,
leaving the others unaffected.

Remember, each effect has four channels, and there are four scenes, so it is
possible to have unique settings in every scene if you want.

One benefit of this approach is that you can share Channels between scenes
where you want them to stay the same. Additionally, since each Channel can
have a completely different Effect Type, you're not just getting snapshots of a
given knob. Instead, it's like having four effects in one!

TIP: If you want only slight changes, use VP4-Edit to copy any Channel to
another before making adjustments. See the next FAQ.

FAQ: Can I Copy/Paste Scenes or Channels?
It is not possible to copy/paste scenes or channels directly on the VP4

VP4-Edit includes tools to copy one Scene to another, however, as long as
you do this inside of a single preset. It is never possible to copy Scenes
across presets.

VP4-Edit also allows you to copy effect channels. Within any block, you can
copy A,B,C, or D to any other channel — or to ALL channels.

You can even copy a channel to the clipboard to be pasted into another block
of the same type — and this even works across different presets!

VP4-Edit also includes a Library which can save any channel—or an entire
block with all four channels and all modifiers—for instant recall at any time
in any preset. Think of this having your favorite settings on speed dial. You'll
need to use the Library in VP4-Edit on a computer, however, since it is not
available from the VP4 front panel.

FAQ: How do Modifiers work across Channels?
Modifiers allow remote control and automation. Learn more beginning on p. 38.

On the VP4, a modifier applies to all channels of the block where it is created. For
example, if you assign an expression pedal to control the “Mix” in one channel,
that pedal will also control the “Mix" in every other channel. You cannot assign a
modifier to only one channel and not the others.

Be aware that within a block, some effect types have parameters that others
don't. In these cases, a modifier might either have no effect or could impact

a different aspect of the sound. For example, a “Hall” reverb offers a “Stereo
Spread” control, but a “Spring” reverb does not. If Channel A is set to a Hall and
Channel B is set to a Spring, a modifier on Stereo Spread won't work while the
Reverb is on channel B.
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Channels Tutorial

This section continues the “Preset Tutorial” on page 28. If you haven't done
so already, please complete that section before continuing.

Set Up Channel B in the Drive Block

»
»

Change to FX Mode.

Press and hold the footswitch for the Drive effect. The
CHANNEL PICKER will appear. Notice that Channel A is
selected. Its footswitch is bright and it is shown with a

white dot. The text beside each channel in the Picker shows
the currently assigned Effect Type for that channel.

Change to Channel B by pressing footswitch 2.

Press ENTER to edit the Drive.

Because this effect has already been edited, you

will arrive first at the first page of knobs. Press

Page Left to go back to the Type picker.

Turn SELECT or knob A to highlight the “Tube Drive 3-knob” type.
Press ENTER or Page Right to show the settings for the Drive.
Dial in the Tube Drive however you like and

press EXIT when you're done.

Repeat the above steps to dial in Channel C

and Channel D for the drive block.

o Use the CHANNEL PICKER to change the drive to Channel C.

o Dialin Channel C however you like it and press EXIT when you're done.

o Use the CHANNEL PICKER to change the drive to Channel D.

o Dialin Channel C however you like it and press EXIT when you're done.

When you're finished, set the Drive Block back
to Channel A and save the preset.

Your Drive now has four channels set up to play!
Now continue to the Scenes Tutorial (right).

SCENES & CHANNELS

Scenes Tutorial

Set Up and Save Scene 1

4
4

»

Change to Scene Mode and select Scene 1 by tapping footswitch 1.

Change to Effects Mode and set up the FX as follows:
Phaser: OFF, Drive: OFF, Delay: OFF, Reverb: ON

Make sure the Drive block is on Channel A.

o Press and hold the footswitch for the Drive effect. The CHANNEL PICKER will appear.
Tap footswitch 1 to select Channel A.

Save the preset by pressing SAVE. Turn SELECT to the Scene 1 Name
row and use knobs A, B, C, and D to enter the name “Reverb”.

Press ENTER twice to save all of these changes.

Set Up and Scene 2

4
4

»

Change to Scene Mode and select Scene 2 by tapping footswitch 2.

Change to Effects Mode and set up the FX as follows:
Phaser: ON, Drive: ON, Delay: OFF, Reverb: ON

Make sure the Drive block is on Channel A.

Set Up and Scene 3

»
»

Change to Scene Mode and select Scene 3 by tapping footswitch 3.

Change to Effects Mode and set up the FX as follows:
Phaser: ON, Drive: ON, Delay: ON, Reverb: ON

Change the Drive block to Channel B.
o Press and hold the Drive effect footswitch to use the CHANNEL PICKER.

Let’s learn to adjust Scene Levels. Press HOME.
Press Page Right 2x to go to the preset Main Levels page.

Use SELECT and knob C to set Scene 3 Level to +4.00 dB (for a boost).
Press HOME when this is done.

Set Up and Scene 4

>
>

Change to Scene Mode and select Scene 4 by tapping footswitch 4.
Change to Effects Mode and set up the FX however you want.

Save Everything and Try It!

» Press SAVE. Enter names for Scenes 2, 3, and 4. Press ENTER 2x when you're done
» Change to Scenes Mode and try out all four scenes using the footswitches.
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Modifiers

Modifiers are one of the most exciting features in the world of Fractal Audio.
They allow effect parameters to be remote controlled or automated in real time.
With modifiers, the creative possibilities are practically limitless: control the
sweep of a volume pedal, wah, or whammy, the rate of a modulation effect like
phaser or rotary, the gain of a drive, the input gain (“send level”) of a reverb or
shimmer, and more.

Starting simply, you might assign a connected expression pedal. Digging deeper,
you'll discover other “sources” to use instead of pedals: every preset has its own
LFO, Envelope Follower, Sequencer, a Pitch Follower, and an ADSR “envelope
generator”. You can also use a MIDI CC# message via an "External Controller."

Modifiers can also be stacked, so, for instance, one pedal could simultaneously
adjust delay feedback, mix, and more. Additionally, you decide both the
minimum and maximum range that the target parameter should change. For
example, a reverb mix could range from 0-100%, or be limited to just 25-40%.
Expert users will enjoy the ability to dial in custom curves and more. Each preset
can have up to 16 different modifiers in total.

Modifiers are easy to use but offer fantastic potential for those who want
extreme creativity or control.

CREATING A MODIFIER

The process of creating a modifier starts at the parameter you want to control.
Parameters that support modifiers are marked with a yellow circular symbol
(illustrated below). When a modifier is already assigned, the circle appears solid,
like a yellow LED that's turned ON. This symbol can appear on knobs, switches,
text parameters, sliders, or any other type of control.

©) O,

m oText 100%

The filled circle
means a modifier is
already present.

The open circle
means you can add
a modifier here.

Here, a switch and
a text parameter
allow modifiers.

MODIFIERS & CONTROLLERS

TO CREATE A MODIFIER

» Select any parameter that supports a modifier. Look for the yellow circle.
» Press the ENTER button to show the Modifier screen

» On the Modifier screen select the Source you want to
use to control the parameter — for example, “PEDAL 1.
The basic modifier page also allows you to:
o Select a Source to control your parameter. (Learn more on the next page.)

o Set the Range for the parameter being controlled. For example, a Volume
pedal might be set to range from 0.0 (silent) to 10.0 (max) or might be limited
t0 8.0—10.0, going from "slightly dialed down" to "full on".

o You might want to set up Auto-Engage (p. 39) which activates the effect
based when the modifier is used.
NOTE: This disables normal ON/OFF footswitch control of the effect, but
eliminates the need for an extra stomp, or a separate toe-switch.

o You can adjust the Performance "Update Rate".
The “Fast” setting is the smoothest but uses a bit more CPU.

» Press EXIT to leave the modifier menu.
» SAVE the preset to save the modifier.

TO EDIT OR REMOVE A MODIFIER...

To edit an existing modifier, use the process above for creating a modifier.
» To remove a modifier, simply change its SOURCE to “NONE".

FAQ: Why Can't I Change a Setting once it has a Modifier?

You can't manually adjust a parameter that is under the control of a modifier.
Modifiers are shared across all channels, so plan accordingly.

In the event you want to remove a modifier and can't find it, or when a modifier
on one channel causes unexpected results on another, you can find a list of all
modifiers in the current preset in the Controllers menu. See p. 42.
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Modifier Settinas

MODIFIERS & CONTROLLERS

The Modifier screen contains settings to control how the modifier works.

SOURCE

The Source is the controller which drives a modifier. There are 12 options:

» Pedal 1, 2 - Use these to directly assign pedals or switches connected
to the VPA4. Instruction for setting these up begin on p. 13.

= External 1, 2, 3, 4 - External Controllers allow you to assign MIDI
CCs as modifier sources. They can also be set globally to either of
the onboard PEDAL jacks. To assign a CC or pedal globally to any
of the 4 External Controllers, open SETUP > MIDI Remote, scroll
down using SELECT, and then turn A to assign the desired value.

= LFO A, LFO B, ADSR, Sequencer, Envelope - The VP4 includes
four “Internal Controllers” that can be used as modifier sources.
Settings for these sources can be found in the Controllers menu
(p.42) and are saved independently in every preset.

» Pitch - The Pitch Detector analyzes the pitch of your playing and
outputs a low value for low notes and a high value for high notes. It is
keyed to the lowest and highest notes on a standard 6-string guitar.

* None - Assigning this controller removes the modifier from a parameter.

PARAMETERRANGE

The Range settings define Min and Max points for how the target parameter
responds to the source. These allow you to fine-tune sound changes.

EXAMPLE 1: The modifier for a pedal controlling Delay Feedback has Min at
“10%" and Max at “50%". The feedback sweeps only from 10% to 50 as the
pedal is moved, even though this parameter’s normally goes from -100% to
+100%.

EXAMPLE 2: The modifier for a pedal controlling Rotary Rate has Min at “0.67
Hz"” and Max at “6.5 Hz" (classic “chorale” and “vibrato” speeds for a Leslie).
Meanwhile, the rate can actually span from range 0 (parked) to 10.0 Hz.

AUTO-ENGAGE

If you've ever used a Wah pedal without a toe-switch, you'll quickly grasp the
concept of “Auto-Engage.” Just like a Wah that automatically turns on when

you push it forward and bypasses when you pull it back, Auto-Engage works
similarly but can be applied to any effect. Once you try it, you may find that it
comfortably eliminates the need for expression pedal “toe” switches.

Auto-Engage engages or bypasses any block when the Source of a modifier
changes. It has two settings:

Auto-Engage - Determines whether or not the block will automatically engage
or bypass. FAST, MEDIUM and SLOW settings determine how quickly the effect
turns ON/OFF when Auto-Engage is triggered. Use SLOW settings to “relax”
auto-engage, so your effect doesn't switch off too suddenly while you're still
using it.
o POSITION (“POS") options trigger the effect based on OFF VALUE (see below).
o SPEED (“SPD") options engage the effect when the controller is moved quickly.
o Choose “OFF" to disable Auto-Engage.

Off Value - Sets the position threshold that the source must cross for auto-
engage to occur. If Off Value is below 50%, the effect bypasses when the
controller goes below the threshold. If it's set to 50% or higher, the effect
bypasses when the controller goes above the threshold. For “heel down =
bypassed,” set to 5%. For “toe down = bypassed,” use 95%.

PERFORMANCE

Update Rate controls how often the modifier is refreshed. The setting of
slow is in fact still very fast, and fine for the vast majority of applications.
The faster settings require additional CPU but provide even smoother sound
performance when ultra fast changes are required (while using a fast LFO on
a filter, for instance). Adjust this setting if you think you hear “zipper noise”
while a modifier is in use.

EXPERT OPTIONS

In the same way that effects allow “Expert” editing (p.25), so do Modifiers.
The next page covers these additional options.
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MODIFIERS & CONTROLLERS

Expert Modifier Settings
Modifiers support “Expert” editing (p. 25) in the same ~ wast  paser CO
way effect settings do. To show the Expert settings for +O= @ S
any modifier, first display its basic Modifier page, then

switch to Expert mode by pressing Page Left and Page Right at the same

time. All of the basic Modifier settings (previous page) also appear in expert
mode, plus the following additional options:

C izing S p ter C
Start, Mid, End, Slope, Scale, and Offset are used to create custom curves
which re-map the relationship between the modifier source and the value of
the target parameter. A graph shows the relationship between the source
(x-axis) and the parameter (y-axis). The dot on the graph tracks the source.

The default settings (first graph below) create a 1:1 linear relationship
(the blue line) between source and parameter. As the source changes, the
parameter tracks it directly.

The other examples below show examples of the kinds of shapes and curves
you can create using Start, Mid, End, Slope, Scale, and Offset.

Parameter ==

Source ==

Damping

Attack and Release: These values apply “damping” to slow the rate at
which the target parameter value chases the source. Attack determines the
rate of change as the source is increased, and Release controls the rate as
it decreases. At low settings, these add just a little smoothing. Try settings
of about 10 ms to “relax” a pedal or to ease the edges of a square LFO to
eliminate clicks and pops. Higher settings can cause sound changes to be
extremely slow and lazy.

PC Reset

PC Reset allows you to set a specific value for an external controller when a
preset first loads. This feature temporarily overrides the actual position of the
external controller until it is physically moved or updated.

Here's how it works:
» While setting up a modifier, turn PC Reset to “ON.”
» Save the preset.

» Return to editing the effect and locate the parameter that
has the modifier applied. Normally, you wouldn’t be able to
adjust the value of that parameter directly. However, with PC
Reset turned ON, you can set and save a specific value.

» This value will be used when the preset loads, until the external controller
(like a pedal) is physically moved, which then updates the parameter.

MODIFIERTIPS&TRICKS

» The same source can be assigned to multiple modifiers at the
same time. For example, one pedal might adjust Chorus Rate and
Chorus Depth at the same time — even in different ways.

» Modifiers use a very small amount of CPU power while you use
them. Test any presets which seem close to the edge.

» Inaddition to Auto Engage, you can also assign
modifiers to the “Bypass” parameter.

» The LFO, Sequencer, and ADSR are used as modifier sources, but
these also have parameters of their own which can be controlled
by a modifier. For example, an expression pedal can control the
rate of the Controller LFO. An Envelope can turn the Sequencer on
or off. The potential for creative sound design is immense!

» The last page of the Controllers menu contains a list of all of
the modifiers used in the current preset. When you select one of
these, you can press ENTER to open that modifier for editing.
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Modifier Tutorial: Wah

MODIFIERS & CONTROLLERS

This tutorial will help you learn to create a modifier. If you've already set up an
expression pedal for use with your VP4, you can use that pedal here. If not, you
can add one using the instructions on p. 13, or use the option below to create
an “LFO wah" instead, requiring no pedal.

1. Select any preset that does not already contain a Wah block.

o To select a preset, enter Preset Mode and use Knob A and ENTER.
2. Turn SELECT to highlight the effect slot where you want to place the Wah.
3. Turn the Type knob below the desired slot to "WahWah" and press ENTER.
4. Press ENTER to edit the Wah.
5

. Select a type such as "Cry Babe" and press Page Right to the settings for
the Wah.

6. Select the top row of controls, then turn knob A to select the “Wah
Control” setting. This highlights it in blue.

7. Press ENTER to show the Modifier screen.

8. The “Source” setting will be highlighted. Turn Knob A to select “Pedal 1"
(Option: You can also use “Pedal 2" if you have it set up, or if you don't have a
pedal, try “LFO A".)

9. Test your pedal. You should hear the wah working, and see the on screen
dot moving while you move the pedal.

OPTION: If you want the Wah block to bypass automatically when you move the
pedal to the heel position, change “Auto-Engage” from “OFF” to any of the other
options, such as “Medium Position”.

10. Press EXIT return to the Wah edit menu.
11. SAVE your preset if you want these changes to be permanent.

Next Steps: Try a Sequencer Wah

1. Start with the preset you created using the tutorial in the left column.
2. Onthe HOME page, turn SELECT to highlight the Wah.

3. Press ENTER to edit the Wah.

4. Find and highlight the “Wah Control” knob, then press ENTER to open the
modifier screen.

5. Change the source to “Sequencer”. The sequencer is one of the on-board
controllers that can be programmed independently in every preset. We'll
adjust it in a moment...

6. Scroll down on the Modifier page and make sure Auto-Engage is set to
“OFF”.

7. If your Wah is bypassed, turn it on now using the appropriate footswitch.

8. Now let’s edit the sequencer. Press HOME and then Tap Page Right
repeatedly until you land on the Controllers page.

9. Press ENTER to open the Controllers menu.

10. Page to the Controllers > Sequencer page.

11. Select the top row. Change Run to “RUN". Set Steps to “8”

12. Select the 2nd row. Use knobs A-D to Set Steps 1-4 as desired.

13. Turn SELECT one click to the right. Set Steps 5-8 as desired.

14. You can continue to explore the Sequencer, or press HOME when finished.

15. Don't forget to SAVE your preset if you want to make these changes
permanent.



& VP4 OWNER’S MANUAL

The Controllers Menu

MODIFIERS & CONTROLLERS

The Controllers menu contains Internal Controllers provided for use as
modifier sources. It also provides access to preset Tempo settings.

To view or edit these Internal Controllers:

Load the desired Preset
Press Home, and then press Page Right six times to CONTROLLERS.
Press ENTER to open the Controllers menu

You can page left and right to access Tempo, LFO, Envelope
Follower, ADSR (Envelope Generator), Sequencer, and
the Modifiers overview for the current preset.

» Press HOME or EXIT at any time to exit the Modifiers menu.
» If you want to save your Controller changes, save the entire Preset.

Controllers > Tempo

v Vv v Vv

The Tempo page allows you to view or change the tempo, change tempo
setting for the current preset, and turn on a metronome to use for practicing.

Tempo - Sets a specific tempo such as 90 beats per minute (BPM).

TIP: While you're on this page, the ENTER key allows you to tap the desired
tempo. The Tap Tempo feature has two modes: "AVERAGE” - which results in
smooth changes over multiple taps and “LAST TWO”, which sets the tempo
instantly after just two taps. You can choose the desired option in SETUP >
Global Settings > Tap Tempo Mode.

Tempo To Use - Determines how the VP4 behaves when the preset loads.
The choices are:

o GLOBAL TEMPO: The Global Tempo value is a system setting independent of
any preset or effect. When you load a preset with this setting, the tempo does
not change from whatever it was previously.

o PRESET TEMPO: When you load a preset with Tempo To Use set to “PRESET,”
the saved Tempo value takes over.
(Note: The Global Tempo remains set in the background and will be used when
you load a different preset with “Tempo To Use” set to “GLOBAL.")

Metronome - Adjusts the level of a built in metronome, handy for practicing.

Controllers > LFO (A/B)

An LFO (Low-Frequency Oscillator) generates a slow, repeating signal that can
modify various aspects of a sound. Common examples include the pulse of
a tremolo, the sweeping motion of a phaser, or the random filter effect heard
in Frank Zappa’s “Ship Ahoy.” The Internal Controller LFO can be assigned as
the source for any modifier, enabling you to craft a wide range of interesting

effects. It offers the following settings:

Rate, Tempo - You can manually set the rate in Hertz, or synchronize itto a
rhythmic value in time with the VP4's tempo.

Depth - This controls the amplitude, or intensity, of the LFO, adjusting how
prominently it affects the sound.

LFO Type - Sets the waveform shape. Options include classics like Sine,
Triangle, Square, Saw, and Random, as well as more specialized shapes like
Log, Exponential, and Astable, which simulates certain analog LFOs.

Duty and Shape - These alter the waveform in distinctive and useful ways.
Adjusting the Duty of a Square wave, for instance, controls the proportion of
time that the waveform stays in its “high” state versus its “low” state during
each cycle. The best way to understand these controls is to observe the
waveform graph while making adjustments.

High Cut - filters the waveform, smoothing out aspects of its shape.

Quantize - This converts smooth waveforms into stepped ones. For example,
applying Quantize to a Triangle waveform will change its smooth, continuous
rise and fall into a series of distinct “terraces”.

Run - Starts and stops the LFO. This can be used to assign a Pedal/Switch
or Envelope Follower to trigger the LFO, or to start/stop it via MIDI, ensuring
perfect alignment with a track.

Output B Phase: The LFO outputs two signals, and you'll see LFO A and LFO
B listed in the modifier sources. You can use this control change the Phase of
output B with respect to A.
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Controllers > Envelope Follower ~ Controllers > Modifiers

The Envelope Follower generates a control signal based on the dynamics of
your playing. You can fine-tune its sensitivity and response time, making it
ideal for “touch” effects that react to how hard or soft you play.

You can independently set Attack and Release times, adjust the trigger
Threshold, and control the input Gain. Additionally, Low Cut and High Cut
filters let you shape the response without altering what you hear. A meter
shows the response in realtime while you play.

Controllers > ADSR

MODIFIERS & CONTROLLERS

The ADSR controller is an envelope generator. Once triggered, it changes its
output value over time with adjustable settings for Attack, Decay, Sustain,
Sustain Level, and Release ("ADSR"). A graph visually represents the effects
of these settings as you make adjustments.

The ADSR is triggered when the signal level surpasses a set point called the
Threshold. A Type parameter lets you choose between Linear and Exponential
curves. You can observe the graph to see how these settings affect the
envelope.

The ADSR has three modes—0nce, Loop, and Sustain—and can optionally
be set to Retrigger every time the signal level goes above the set point,
rather than needing to play all the way through before retriggering. Unlike
the Envelope Follower (above) the ADSR envelope generator produces the
same control signal each time, but only triggers when you play with enough
intensity.

Controllers > Sequencer

The Step Sequencer brings rhythm and movement to a sound by creating
control patterns. Rate and Tempo allow you to define the speed of your
sequence, while Stages lets you select the number of steps in the pattern. Use
the Run switch to start or stop the sequence, and the Step button to advance
the sequence manually. Finally, Damping Time smooths the transitions
between stages, giving your pattern a more fluid, less abrupt feel.

The last page of the Controllers menu is the Modifiers list, which displays all
the modifiers in the current preset. You can edit any modifier in this list by
selecting it and pressing ENTER. Each preset can include up to 16 modifiers,
but remember that each one also demands a tiny slice of CPU!

Pitch Detector
The Pitch Detector is available as a Source for modifiers, though it doesn’t
appear in the Controllers menu since it has no adjustable parameters. It
analyzes the pitch of your playing, outputting a low value for low notes and a

high value for high notes, calibrated to the range of a 6-string electric guitar in
standard tuning.

External Controllers

External Controllers are also Modifier Sources, but they need to have a control
source assigned to them in order to function. For each of the four External
Controllers, you can globally assign PEDAL 1, PEDAL 2, or any MIDI CC#
message.

For example, if you want to use MIDI CC#11 to operate a Wah effect, you
would first assign “CC#11" to External 1 in global SETUP, and then use
External 1 as the Source of a modifier controlling the Wah.

While this proxy method is indirect, it has several advantages. First, it allows
you to share presets between those who use different pedals in different
ways, providing an easy way to make global changes instead of editing every
preset. One person might use PEDAL 1 as a Global Volume while another
uses it for Wah, Whammy and other flexible scenarios. Yet another might
connect a MIDI controller with its own onboard pedal that transmits CC#11.

External Controllers assigned to MIDI are given a value of “0” until some
MIDI data is received to change them. The External Controller Initial Value
parameters can change the startup value for a MIDI controller to any value.
Then, when the VP4 is powered on, any modifiers assigned to the missing
controller will be at the desired value instead of at 0.

Find the options to assign and set the initial value for External controllers in
the SETUP > MIDI/Remote menu.
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The Setup Menu

As noted in the introduction to this manual, the Setup menu contains various
global settings, options, utilities, and information, with pages for Audio,
Pedals, Footswitches, MIDI/Remote, Settings, Reset, and System Info.

OPENTHESETUPMENU
» Press ENTER and EXIT together. ENTER EXIT

» Use PAGE LEFT and PAGE RIGHT QSETUPQ
to navigate the menu.

» Press EXIT to go back to wherever you came from.

Changes in SETUP are stored automatically as you make them.
When this happens, the title bar of the VP4 will display “SAVING...".

Do not power while the VP4 is saving, or your most recent changes
could be lost.

The following pages contain a complete reference detailing every page and
option in the Setup menu.
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SETUP > Audio

THE SETUP MENU

PARAMETER Description
Input Meter This meter shows the audio level in the VP4 after the Input Pad (see below). The meter turns red when input clipping occurs.
Input Pad The Input Pad setting can be adjusted from 0 dB (for low-level input signals) to 6 dB, 12 dB, or 18 dB (for progressively louder

0,6dB,12dB, 18 dB

Input Mode
MONO, STEREO

Input Source
Analog, SPDIF, USB 3/4

Output Mode

STEREQ, SUM L+R,
COPY L->R, MUTE

Output Phase

NORMAL/INVERT
USB 1/2 & 3/4 Level

-40.00 - +20.00 dB

input signals). The default Input Pad setting is 12 dB, which is ideal for guitars with hot pickups.

When the input clips, the words “IN CLIP” also appear in red in the title bar of the main display, indicating the need to increase the
pad setting.

Automatic Input Pad Adjustment: If the input of the VP4 clips persistently, the unit will automatically increase the Input Pad
setting. When this occurs, the word “Auto” will appear next to the Input Pad value, for example: “12 dB (Auto)” indicating that
the pad was automatically increased to 12 dB. When you reboot the VP4, the automatic setting is cleared, and the last manually
selected value is restored. If you want to make the automatic pad setting permanent, just turn the Input Pad knob one “click” to
clear “Auto” and set the desired value. While "4CM Routing" is enabled, a common input pad setting is shared by both PRE and
POST inputs. Excessive levels at either of these will cause the automatic pad setting to be applied to both.

If the input still clips with the pad setting at 18dB, decrease the output level of the device(s) connected to the VP4 input(s).
Determines whether the VP4 accepts signal in mono or stereo.

When using the VP4 with a single input, set the Input Mode to ‘'MONO' and connect to the L/Mono input only.

When using the VP4 as a stereo device, make sure to set the Input Mode to "STEREQ" and always connect cables to both the left
and right inputs (L/Mono and Right).

The Input Mode setting is overridden when the global "4CM Routing" option is ENABLED.
Sets the input source, selecting between Analog (the onboard jacks), SPDIF (the onboard SPDIF IN connector) or USB Channels
3/4, which appear as outputs on a connected computer. See p. 15 for more on USB.

Connect only 48k streams to the SPDIF input, as the VP4 will automatically derive its 48k clock signal from the detected input.
This setting determines how signal is processed at the analog outputs. This control makes it easy to use the same presets in a
variety of stereo and mono environments.

USB and SPDIF Audio goes directly to the converters in stereo and is NOT affected by this setting.
The option “MUTE" is available in case you want to eliminate analog audio from the VP4 while using it with a DAW.
The Output Mode setting is overridden when the global "4CM Routing" option is ENABLED.

See Mono vs. Stereo on p. 11 for more on how the VP4 processes audio internally.
Determines whether signal at the output will be normal or phase-inverted relative to the actual output of the input or effects.
You can use this in a pinch to correct phase inversion problems elsewhere in your setup.

The USB 1/2 Level and USB 3/4 Level parameters adjust USB playback levels from -40 to +20 dB. While computer audio playback levels
are typically set on the computer itself, these controls are useful when you need an additional boost or cut.
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SETUP > Footswitches

The footswitch page allows you to designate how Press & Hold works on the VP4.

Note: The default “Gig Mode” (see p. 6) has a press and hold function on every footswitch. This causes effects and other tap functions to fire when you release the
switch instead of when you tap it. You can completely disable all press and hold function, or even assign custom functions using Press & Hold Mode, below.

PARAMETER Description
Press & Hold Mode Selects between available options for global press and hold footswitch functions.

Disabled - Disables all press and hold functions. Every operation must be executed using the knobs, buttons, and tap switches.
Gig Mode - Selects a ready-to-play set of custom press-and-hold functions. See p. 6 for full details.
Custom Mode - Allows you to select between various options for press and hold on the four switches.

Hold Timeout This sets the time limit before any Hold function is fired, beginning from the moment the switch is depressed. When a Hold function is
0.25-2.00 Seconds  assigned, a Tap function fires if the switch is released before the press and hold timeout elapses.
Tap a switch WITHOUT Tap a switch WITH Hold Function
a Hold function a Hold function Under a Tap Switch
Press and Hold Timeout Press and Hold Timeout
(0.50 seconds by default) (0.50 seconds by default)
A -
v V2 A V. —A
Tap function fires at the A Hold function DELAYS the When you hold a switch, its
moment you tap the switch, Tap function until you release HOLD function fires once the
just like an analog pedal. the switch, as long as this Timeout runs out. The Tap
happens before the Timeout. function does not fire.

Custom Press & Hold 1 These four parameters provide the option to assign optional global Press & Hold functions to the four footswitches of the VP4.
Custom Press & Hold 2 These options are shown when Press & Hold Mode is set to “CUSTOM". IMPORTANT: Any custom assignment is global across every mode.
Custom Press & Hold 3

Disabled - The selected footswitch has no hold function. It's tap function fires at the moment the switch is depressed.
Custom Press & Hold 4

Mode Select - The mode select screen is displayed, just as if you had pressed HOME + SAVE.

Preset Mode, Scene Mode, FX Mode, Tuner Mode - The VP4 changes to the designated mode.

Bank +1, Bank -1 - The VP4 switches to the next or previous bank of four presets. Which ever preset was selected in the
Preset +1, Preset -1 - The VP4 switches to the next or previous Preset.

Scene +1, Scene -1 - The VP4 switches to the next or previous Scene.

Channel Picker - Shows the 4-button “Channel Picker” for the corresponding effect. For example, if this function
is assigned to switch 3, holding Switch 3 = will show the channel picker for the effect in slot 3.

» VP4 Bypass - Engages analog bypass for the VP4,

v Vv Vv Vv Vv v Vv
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SETUP > Pedals

PARAMETER Description
Pedal 1 Type Set this according to the what you have connected.
Pedal 2 Type EXPRESSION PEDAL - Choose this option when connecting an expression pedal such as the Fractal Audio EV-1 or EV-2. 3rd party

expression pedals should have a linear resistance taper and must have a maximum resistance in the range of 10-100kQ. Expression
pedals must be used with Tip-Ring-Sleeve (TRS) cables.

Each pedal jack can also support one switch. The use of dual switches is not supported.

SWITCH (Any, Follow Hardware) Use this setting when you connect a latching switch, or when you connect a momentary switch and
want momentary action.

SWITCH (Momentary, Virtual Toggle) Use this setting to cause a connected momentary switch to behave like a latching/toggle
switch.

Calibrate PEDAL 1 These options allow you to calibrate expression pedals connected to an onboard Pedal jack.

Calibrate PEDAL 2 » Select the appropriate option and press ENTER.

» Move the pedal through its full range of motion several times. The meter will show the actual response of your pedal, which
does NOT need to fully reach the top or the bottom but should show motion across the majority of the range.

» Press ENTER again when finished.

» The mini-graph on the main Pedals page now shows the output of your calibrated pedal.
If it does not range from 0-100, calibrate again or check your cable, pedal, etc.

Remember: Switches, unlike pedals, do not need to be calibrated but should still display 0-100 on the mini-graph.
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SETUP > MIDI/Remote

THE SETUP MENU

PARAMETER Description

MIDI Channel Sets the channel on which the VP4 will receive MIDI messages.

1-16, OMNI OMNI" causes the unit to respond to incoming messages on all channels.

MIDI Thru This enables or disables MIDI thru, which causes messages received at the MIDI In port to be merged with any internally generated

Off, On MIDI data at the MIDI Out port.

Receive MIDI PC Determines whether the VP4 will process or ignore incoming MIDI Program Change messages.

ON/OFF

Send MIDI PC Determines whether or not the VP4 will automatically transmit a MIDI Program Change message at its MIDI OUT port when a new

1-16 preset is loaded. This is the easiest way for most people to operate a single connected MIDI device while changing presets on the

OMNI FM3. Any custom MIDI mapping is left to the downstream device. To use this feature you simply select which channel you want the

OFF message to be transmitted on. The “OMNI” setting transmits the message on all channels.

Ignore Redundant PC This setting determines whether the VP4 should re-process or ignore a Program Change message that corresponding to the current

ON/OFF preset. With this setting “OFF”, a preset will be reloaded—all changes discarded—when it is selected again via PC. This allows you,
for instance, to load a preset, use footswitches to toggle effects, and then reload the preset to have it revert to its saved state.

INITIAL VALUE: These parameters specify the initial value to be used for each of the External Controllers (p. 43) when the VP4 is powered on.

External Control 1-4

This value persists until data is received from a MIDI controller. This is especially useful when an external MIDI controller is absent.
For example, if you normally use a MIDI expression pedal to control the volume in your presets, a missing controller might make the
preset get “stuck” in a muted position. Setting an initial value of 100% for the External Controller mapped to that MIDI pedal would
ensure that when the pedal is not connected, the volume will stay at 100% instead of 0%.

This setting is only for controllers with a MIDI CC# assignment. It does not apply to locally connected pedals or switches.
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THE SETUP MENU

SETUP > Pedals (Continued)

PARAMETER Description

Input Volume These individual parameters allow you to globally control the input or output levels of the VP4.

Output Volume Use these for convenient global Volume without needing to “waste” one of the effects on a Volume block.
Tempo Tap Provides the ability to tap the tempo using an external switch. Learn more about Tempo on p. 12

Tuner Provides a way to remotely enter or exit the Tuner.

Tuner on Heel Down

FX 1,2,3,4 Bypass
FX 1,2,3,4 Channel
External 1,2,3,4

External 1,2,3,4 Initial Value

Preset +1, Preset -1
Scene Select

Scene +1, Scene -1
VP4 Bypass

You can set the VP4 to automatically display the tuner when the designated Pedal or MIDI CC is in the “Heel Down” position (<5%).
This feature works best when the same controller is also assigned to Input Volume or Output Volume, allowing the tuner to pop up
when you turn the volume down.

These four options allow you to use external switches or MIDI messages to bypass or engage the four FX of the VP4.
These four options allow you to use external switches or MIDI messages to set the channel for each of the four FX of the VP4.

External Controllers are Modifier Sources that require data from an input such as a Pedal Jack or a MIDI CC# message to function.
For instance, if you want to use MIDI CC#11 to control a Wah effect, you would assign CC#11 to External 1, then use External 1 as
the Source for a modifier in the Wah block.

Think of an External Controller as a “proxy” that connects your physical or MIDI controller to effect parameters.
For each of the four External Controllers, you can assign PEDAL 1, PEDAL 2, or any MIDI CC#.

See p. 43 for more on External Controllers.

On the MIDI/Remote page, you'll find the four INITIAL VALUE parameters at the bottom. These allow you to set the default startup
value for External Controllers assigned to MIDI. This assigned value will remain active until the appropriate MIDI CC# message is
received to update it.

These two settings allow you to step up or down through the presets of the VP4 using MIDI CC# messages.

This feature allows you to choose specific Scenes based on the value of a MIDI CC message sent to the VP4. The value refers to the
data associated with a particular MIDI CC# message, not the CC# number itself. For example, if you assign MIDI CC#17 to control
Scene Select, the value sent for CC#17 (ranging from 0 to 127) determines which Scene is loaded:

2 = Scene 3 4 = Scene 5 6 = Scene 7

3 =Scene 4 5=Scene 6 7 =Scene 8

The series continues, cycling through scenes 1-8 for values 8 through 127.

These two settings allow you to step up or down through the Scenes of the current preset using MIDI CC# messages.

The VP4 features buffered analog bypass. This passes signal directly from the input to the output with no digital conversion, latency,
or digital processing. If you want to control analog bypass using a connected pedal/switch or MIDI, choose the desired option here.

0 =Scene 1
1 =Scene 2
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SETUP > Global Settings

THE SETUP MENU

PARAMETER Description

Gapless Changes On the VP4, preset, scene, and channel changes are gapless by default. The option to turn this feature off is provided because it can
help conserve a small amount of CPU resources.

ON, OFF

Spillover Allows Delay and Reverb tails to continue ringing out, or “spillover,” when switching Presets. Setting this to “OFF” clears the tail upon

OFF, DELAY, REVERB,
DELAY+REVERB, ALL

Automatic VP4 Bypass

OFF, ON
Tap Tempo Mode

AVERAGE, LAST TWO

Noisegate Offset
+/- 40 dB

AC Line Frequency
60 Hz, 50 Hz

Startup Mode

PRESETS, SCENES, EFFECTS

Default Scene

AS SAVED, 1-8
LCD Contrast

0-100%

preset change. Selecting “ALL" enables spillover for Delay, Reverb, Plex Delay, Multitap, and Megatap blocks.
NOTE: Spillover when bypassing an effector changing scenes is automatic and determined by the Bypass Mode, so it’s not affected
by this parameter.

The VP4 features a buffered analog bypass, which passes the signal directly from input to output without digital conversion, latency,
or processing. To have analog bypass activate automatically when all four effects are bypassed, set this option to ON.

Determines how the tempo is adjusted when tapping the Tempo footswitch, an external tap tempo controller, or the EDIT button on
the Controllers > Tempo page.
“AVERAGE" is based on the average of the last ten taps, making it more forgiving but resulting in more gradual changes.

“LAST TWQ" uses only the last two taps, requiring more precise tapping but allowing for quicker tempo changes.

Globally adjusts the THRESHOLD of the Input Noise Gate, raising or lowering it across all presets. If the THRESHOLD for a specific
preset is set to “OFF" the global Offset will have no effect. This can be particularly handy in situations where the overall noise
environment changes, such as moving between different venues with varying levels of interference or when swapping between
different instruments that might have different noise sensitivity.

Certain types in the Noise Gate use smart EMI filtering to reduce hum and buzz. To ensure optimal performance, set this parameter
to match the power line frequency of your region:

60 Hz for North America, Taiwan, South Korea, some parts of South America and other regions.
50 Hz for most of Europe, the United Kingdom, Australia, China, India, South Africa, the majority of Asia, and parts of South America.

This setting is crucial for the Noise Gate to effectively filter out unwanted noise based on your local power supply frequency.
Sets the mode that will be active when the VP4 is powered on.

When set to “As Saved” the scene selected when recalling a preset is the scene that was active when the preset was last saved.
When set to a particular scene value that scene will always be selected when any preset is recalled.

Adjusts the contrast of the main display.
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SETUP > Global Settings (Continued)

PARAMETER Description

Switch LED “ON" Brightness  These two settings independently adjusts the brightness of footswitch LEDs when they are turned ON or OFF.
Switch LED “OFF” Brightness

1-100%
Fade Selected Effect Timeout On the Home page, the selected effect is highlighted with a yellow box. If you find this distracting while playing, you can set the
OFE 1-10 Seconds highlight to fade after a period of up to 10 seconds. To bring the highlight back, simply turn SELECT by one click, or toggle any effect

on or off.
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SETUP > Reset

PARAMETER Description

Reset System Parameters This utility resets ALL parameters in the SETUP menu and Tuner back to factory default values.
Reset system parameters is a useful step during troubleshooting.
Importantly, this action does not delete or modify your presets.
You will be prompted to press SAVE and then ENTER to confirm.

Always turn your amp or speakers off before performing RESET SYSTEM PARAMETERS on the VP4 . 1) Resetting system parameters
is irreversible; 2) This option can change audio levels; 3) In a rig wired for 4CM, you will need to manually change 4CM Routing back
to ENABLED after performing a Reset.

Clear All Presets This utility allows you to Clear all Presets. You will be prompted to press ENTER to confirm. Be very careful with this option—erasing
presets is irreversible!

If you want to restore the factory presets instead, follow these steps:

» Visit the Download page for the VP4 and download the latest Factory Presets file.
https:/www.fractalaudio.com/vp4-downloads

o On Windows, you'll need to unzip the downloaded file. Mac 0S does this automatically.
» Open VP4-Edit, launch Fractal-Bot from the Tools menu, and follow these steps:
o In Section 2 - CHOOSE A FILE TO SEND, browse to the SysEx file you downloaded.

o Press Begin and then SEND. Allow the transfer to complete. Once done, close Fractal-Bot.
o In VP4-Edit, choose Refresh Preset Names from the Preset Menu.

SETUP > System Info

PARAMETER Description
This screen shows the current firmware version, the date it was released, and CPU usage level.
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SPECIFICATIONS

Specifications

INPUTS

Connectors: (2) 1/4” phone jack, unbalanced

Impedance: 1 MQ (less, w. “Input Impedance” settings applied.)
Max. Input Level: +20dBu

A/D CONVERSION

Bit Depth: 24 bits

Sample Rate: 48 kHz

Dynamic Range: 114 dB

Frequency Response:

20 - 20kHz, +0 /-1 dB

GENERAL
Finish: Powder coated steel chassis.
Controls: 6 buttons, 5 knobs, 4 footswitches.
Display: 480 x 272 high contrast color LCD.
Dimensions: 10.0"W.x2.6"H. x6.31"D.

(254.0mm W. x 66.0mm H. x 160.3mm D.)
Weight: 3lbs 70z (1.56kg)
Power Requirement: 9V DC 1.3A
Power Connector: 2.1mm barrel connector, negative center
Internal Battery: NONE
ENVIRONMENTAL

ANALOG OUTPUTS

Connectors: (2) 1/4” phone jack unbalanced
Impedance: 600Q

Max Output Level: +16dBu

D/A CONVERSION

Dynamic Range: 114 dB

Frequency Response:

20 - 20kHz, +0 /-1 dB

DIGITAL I/0

Connectors: RCA Coaxial Type for S/PDIF in and out

Format: Uncompressed PCM

Sample Rate: 48 kHz fixed

USB AUDIO

Format: USB 2.0 Class compliant, USB Type "C" connector
Channels: 8 (4 in, 4 out, each mapped to specific ports internally)
USB Audio Clock: 48 kHz fixed

MIDI INTERFACE

Input Connector:
Output Connector:

(1) TRS 3.5 mm Female - Type A
(1) TRS 3.5 mm Female - Type A

Thru: No dedicated connector, but incoming MIDI can be
merged to the output by enabling
Setup > MIDI/Remote > MIDI Thru to “ENABLED”
PEDAL INTERFACE
Connectors: (2) 1/4” TRS phone jack
Format: Pedal: 10-100 kQ max

Switch: momentary or latching

Operating Temperature:32 to 122 °F (0 to 50 °C)
Storage Temperature: -22to 167 °F (-30 to 70 °C)
Humidity: Max. 90% non-condensing
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Dimensions

SPECIFICATIONS
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MIDI Implementation

SPECIFICATIONS

Function Tx Rx | Remarks
Basic Channel Default 1 1
Changed 1-16 | 1-16
Note Number True Voice X X
Velocity Note ON X X
Note OFF X X
After Touch Keys X X
Channels X X
Pitch Bend X X
Control Change X 0 Receivable CCs are globally soft-assigned to functions via the MIDI/Remote menu under SETUP. These
include Input and Output volumes, Tap Tempo, Tuner, 4 “External Controllers” (assignable as modifiers
to one or more parameters on a per-preset basis), additional Preset and Scene functions, , and all block
BYPASS and CHANNEL switches.
Program Change True Number 0 0 | The VP4 can transmit PC messages.
Bank Select X 0
System Exclusive Fractal Audio 0 0 | SysExis used extensively for VP4-Edit.
Real time 0 X
Non-Real time X X
System Common Song Position X X
Song Select X X
Tune Request X X
System Real time Clock X 0 | VP4 Global Tempo syncs automatically to MIDI Beat Clock. VP4 does not transmit MIDI clock.
Commands X X
Auxiliary Messages | Local ON/OFF X X
All Notes OFF X X
Active Sense X X
Reset X X
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Warranty

WARRANTY & EULA

Fractal Audio Systems warrants that your new Fractal Audio Systems product
shall be free of defects in materials and workmanship for a period of one (1)
year from the original date of purchase directly from Fractal Audio Systems.

During the warranty period, Fractal Audio Systems shall, at its sole option,
either repair or replace any product that proves to be defective upon
inspection by Fractal Audio Systems.

Fractal Audio Systems reserves the right to update any unit returned for repair

and to change or improve the design of the product at any time without notice.

Fractal Audio Systems reserves the right to use reconditioned parts and
assemblies as warranty replacements for authorized repairs. This warranty
is extended to the original retail purchaser for units purchased directly from
Fractal Audio Systems or one of its authorized distributors or resellers.

This is your sole warranty. Fractal Audio Systems does not authorize any third
party, including any dealer or sales representative, to assume any liability on
behalf of Fractal Audio Systems or to make any warranty for Fractal Audio
Systems. Fractal Audio Systems may, at its option, require proof of original
purchase date in the form of a dated copy of original authorized dealer’s
invoice or sales receipt. Service and repairs of Fractal Audio Systems
products are to be performed only at the Fractal Audio Systems factory or

a Fractal Audio Systems authorized service center. Fractal Audio Systems
may require advanced authorization of repairs to authorized service centers.
Unauthorized service, repair or modification will void this warranty.

DISCLAIMER AND LIMITATION OF WARRANTY

THE FOREGOING WARRANTY IS THE ONLY WARRANTY GIVEN BY FRACTAL
AUDIO SYSTEMS AND IS IN LIEU OF ALL OTHER WARRANTIES. ALL

IMPLIED WARRANTIES, INCLUDING WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR ANY PARTICULAR PURPOSE, EXCEEDING THE SPECIFIC
PROVISIONS OF THIS WARRANTY ARE HEREBY DISCLAIMED AND EXCLUDED
FROM THIS WARRANTY. UPON EXPIRATION OF THE APPLICABLE EXPRESS
WARRANTY PERIOD (1 YEAR), FRACTAL AUDIO SYSTEMS SHALL HAVE NO
FURTHER WARRANTY OBLIGATION OF ANY KIND, EXPRESS OR IMPLIED.
FRACTAL AUDIO SYSTEMS SHALL IN NO EVENT BE LIABLE FOR ANY
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES SUFFERED BY THE
PURCHASER OR ANY THIRD PARTY, INCLUDING WITHOUT LIMITATION,
DAMAGES FOR LOSS OF PROFITS OR BUSINESS, OR DAMAGES RESULTING
FROM USE OR PERFORMANCE OF THE PRODUCT, WHETHER IN CONTRACT
OR IN TORT. FRACTAL AUDIO SYSTEMS SHALL NOT BE LIABLE FOR ANY
EXPENSES, CLAIMS, OR SUITS ARISING OUT OF OR RELATING TO ANY OF
THE FOREGOING. Some states do not allow the exclusion or limitation of
implied warranties so some of the above limitations and exclusions may not
apply to you. This warranty gives you specific legal rights, and you may also
have other rights, which vary, from state to state. This warranty only applies to
products sold and used in the USA and Canada. Fractal Audio Systems shall
not be liable for damages or loss resulting from the negligent or intentional
acts of the shipper or its contracted affiliates. You should contact the shipper
for proper claims procedures in the event of damage or loss resulting from
shipment.
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BY ACCEPTING, INSTALLING OR USING ANY PART OF THIS PRODUCT YOU ARE CONSENTING TO ALL OF THE TERMS AND
CONDITIONS OF THIS ENTIRE END USER LICENSE AGREEMENT (“EULA"). IF YOU DO NOT AGREE TO ALL THE TERMS AND
CONDITIONS OF THIS ENTIRE AGREEMENT, ARE UNABLE OR UNWILLING COMPLY WITH THESE TERMS AND CONDITIONS, YOU
MUST DISCONTINUE USE OF THE PRODUCT IMMEDIATELY AS YOU HAVE NO AUTHORITY OR LICENSE TO USE THE PRODUCT.

TERMS AND CONDITIONS
1) GRANT OF LICENSE FOR PRE INSTALLED OR USER UPGRADED FIRMWARE (“THE SOFTWARE")

Subject to the terms and conditions set forth herein, Fractal Audio Systems, (“FAS”) grants you an individual, personal,
non-sub licensable, nonexclusive license to use this product in accordance with the applicable end user documentation, if
any (the “License”). The user will not, directly or indirectly, reverse engineer, decompile, disassemble or otherwise attempt
to discover the source code or underlying ideas or algorithms of the Software; modify, translate, or create derivative works
based on the Software; or copy (except for archival purposes), rent, lease, distribute, assign, or otherwise transfer rights

to the Software (except as expressly authorized by this Agreement); remove any proprietary notices, comments, terms and
conditions and or labels on or in the Software. As between the parties, you acknowledge that FAS and its licensors retain
their respective ownership of the Software, any portions or copies thereof, and all rights therein throughout the world. Upon
termination of this Agreement for any reason, the License and all rights granted to you under this Agreement will terminate
and you will cease to use the Software. You may permanently transfer the limited rights of use of the Software granted to
you under this Agreement only as part of a permanent sale or transfer of the hardware device containing the software, and
only if the recipient agrees to be bound by the terms and conditions of this Agreement. You acknowledge that you have

no rights in or to, and may not transfer or otherwise authorize the use of, any “beta” or “preview” software of FAS and its
licensors. THIS LIMITED LICENSE TO USE AND TRANSFER THE SOFTWARE IS PROVIDED AS-IS AND IS SUBJECT TO THE
RESTRICTIONS, INDEMNITY AND WARRANTY DISCLAIMERS AND LIMITATIONS OF LIABILITY SET FORTH BELOW.

2) RESTRICTIONS, WARRANTY DISCLAIMERS AND INDEMNITY OBLIGATION AGREED TO BY YOU IN EXCHANGE FOR
LIMITED GRANT OF LICENSE.

YOU WILL ONLY USE THE SOFTWARE FOR LAWFUL PURPOSES AND IN COMPLIANCE WITH ALL APPLICABLE LAWS. YOU
HEREBY AGREE TO DEFEND AND INDEMNIFY FAS AND ITS LICENSORS AGAINST ANY CLAIM OR ACTION THAT ARISES
FROM YOUR USE OF THE SOFTWARE IN AN UNLAWFUL MANNER (INCLUDING, WITHOUT LIMITATION, ANY CLAIM OR
ACTION ALLEGING INFRINGEMENT OF ANY PATENT, COPYRIGHT, TRADEMARK, TRADE SECRET, OR OTHER INTELLECTUAL
PROPERTY; UNFAIR COMPETITION; VIOLATION OF GENERAL BUSINESS LAWS; OR VIOLATION OF ANY OTHER LAWS OR
RIGHTS) OR ANY OTHER USE OF THE SOFTWARE NOT EXPRESSLY AUTHORIZED PURSUANT TO THIS AGREEMENT.

3) IMPULSE RESPONSE EXPORT FOR COMMERCIAL USE

"o

Offering for sale any Impulse Response data (e.g. “Tone Match Export/Save/Dump”, “User Cab Export/Save/Dump”)
created, converted or modified using Fractal Audio Systems hardware and/or software requires a commercial use

license. Recording studios, consultants, and other commercial entities may use these features in conjunction with work
performed for their commercial customers, but the resulting data files created may not be offered for sale or gifted to their
commercial customers or other third parties without a commercial license from FAS and its licensors where applicable.
Contact sales@fractalaudio.com to obtain a commercial license.

4) IMPULSE RESPONSE DATA EXPORT FOR NON-COMMERCIAL USE

If the product supports Impule Response capture and export, you are free to export Impulse Response data for non-
commercial use. This includes producing, converting, or modifying Impulse Response data for yourself, or offering/
distributing such data at no charge to third parties. Creating Impulses for sale requires a Commercial License. Files
created without a commercial license cannot be included for free with another product or package that is offered for sale.
Contact sales@fractalaudio.com to obtain a commercial license.

5) SUPPORT

Subject to the terms hereof, FAS will provide you with e-mail support services for the Software. Under no circumstances
will FAS have any obligation to provide you with hard-copy documentation, upgrades, enhancements, modifications, or
telephone support for the Software.

6) TERMINATION

This Agreement is effective until terminated. Either party may terminate this Agreement upon written notice to the other
party. FAS may also terminate this Agreement immediately, without prior notice or liability, if you breach any of the terms
or conditions of this Agreement. All sections of this Agreement which by their nature should survive termination will
survive termination, including, without limitation, warranty disclaimers and limitations of liability and limitations of use and
transfer of the Software.

7) WARRANTY DISCLAIMER

The software is provided as is without warranty of any kind. FAS disclaim all warranties, expressed or implied, including
but not limited to implied warranties, fitness for a particular purpose, and non-infringement. Some states do not allow
limitations on how long an implied warranty lasts, so the above limitation may not apply to you.

8) LIMITATION OF LIABILITY

NOTWITHSTANDING ANYTHING CONTAINED IN THIS AGREEMENT OR OTHERWISE, YOU AGREE THAT FAS AND ITS
LICENSORS WILL NOT BE LIABLE WITH RESPECT TO THE SUBJECT MATTER OF THIS AGREEMENT UNDER ANY CONTRACT,
NEGLIGENCE, STRICT LIABILITY, INFRINGEMENT OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY INCIDENTAL,
CONSEQUENTIAL, EXEMPLARY OR PUNITIVE DAMAGES OF ANY KIND. SOME STATES DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE MAY NOT APPLY TO YOU.

9) EXPORT RESTRICTIONS

You acknowledge that the Software, or any part thereof, or any process or service that is the direct product of the
Software (the foregoing collectively referred to as the “Restricted Components”) are of U.S. origin. You agree to comply
with all applicable international and national laws that apply to these products, including the U.S. Export Administration
Regulations, as well as end-user, end-use and destination restrictions issued by U.S. and other governments.

10) MISCELLANEOUS

The failure of either party to exercise in any respect any right provided for herein will not be deemed a waiver of any further
rights hereunder of FAS and or its licensors. If any provision of this Agreement is found to be unenforceable or invalid,
that provision will be limited or eliminated to the minimum extent necessary so that this Agreement will otherwise remain
in full force and effect and enforceable. This Agreement will be governed by and construed in accordance with the laws

of the state of New Hampshire without regard to the conflict of laws provisions thereof. You agree that this Agreement

is the complete and exclusive statement of the mutual understanding of the parties and supersedes and cancels all
previous written and oral agreements, communications and other understandings relating to the subject matter of this
Agreement, and that all modifications to this EULA, or any commercial license that you may have obtained from FAS and or
its licensors must be in a writing signed by you, FAS and or its licensors, where applicable, except as otherwise provided
herein. No agency, partnership, joint venture, or employment is created as a result of this Agreement and you do not have
any authority of any kind to bind FAS and or its licensors in any respect whatsoever. In any action or proceeding to enforce
rights under this Agreement, the prevailing party will be entitled to recover costs and attorneys’ fees. All notices under

this Agreement will be in writing and will be deemed to have been duly given when received, if personally delivered; when
receipt is electronically confirmed, if transmitted by facsimile or e-mail; the day after it is sent, if sent for next day delivery
by recognized overnight delivery service; and upon receipt, if sent by certified or registered mail, return receipt requested.
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Factory Preset Notes

ATl:
A2:
A3:
A4:
B1:
B2:
B3:
B4:
C1:
C2:
C3:
C4:
D1:
D2:
D3:
D4:
E1:
E2:
E3:
E4:
F1:
F2:
F3:
F4:
G1:
G2:
G3:
G4:
H1:
H2:
H3:
H4:

Virtual Pedalboard
70s Pedals

Vintage EHFX >
Bossy FX

Country Living
Rotary Scenes >
Mod Squad Pedals >
Mod Squad Racks >
Drive Drive Drive!
Drives on Display
Distortion Explorer
Fuzz Into Fuzz
Chorus Collection
Flange Factory
Phaser Plethora
Trem-A-Lo-Los

Blackpanel Dad Rock

Grab and Go
Bari Tony

Fuzzy Synth Octaves

Celestial Verbs
Poly Octave Gens
Funk U Tron
Good Vibes

AW Clean

AW Tele

AW Lead FX
Spaghetti Western
MF Box o' Crunch
MF Clean

MF FAS

Z0SO0 FX

FACTORY PRESETS

Four basic effects in a simple pedalboard for a pedal platform amp.

Another take on the basic pedalboard with a throwback feel. This one has a Wah with auto Engage mapped to Pedal 1

Pedalboard with effects based on four classics.

Collection of colorful stompboxes. So many of us began with these classics and they're still on our boards today.

Break out your Tele and get to chicken pickin'! Each effect has four full dialed in channels. From AustinBuddy

Classic Rotary Speaker Tones with four Scenes. Scene 3 is a blend of dry and Rotary. In Scene 4, you can use Pedal 1 to control the speed.
Rare 80s modulation effects. Most of the channels on the 4 effects are dialed in for stereo. By Leon Todd and M@

Modulation pedals collection. Based on a preset by Leon Todd.

Stacked Drive Pedals for classic staging. Try them alone, or combine them in interesting ways. Don't miss channels! AustinBuddy.
Four Drive pedals with four ABCD settings = 16 different drive block tones dialed in by AustinBuddy. There's also a boost.

8 different distortion-specific types in two blocks, plus four GEQ pre-block tonal sculpture options and a delay

If you love fuzz, you probably love more fuzz. Here, they're stacked two at a time with different disgustingly beautiful textures to explore.
A collection of chorus effects. Get to know some of the available types offered side by side. Based on blocks by AustinBuddy.

Four flangers to try, plus the "Andy's Mistress" effects from Axe-Fx Ill.

A plethora of phasers. Use this preset to get to know some of the available types offered side by side. Based on blocks by AustinBuddy.
Sample four of the many different styles of Tremolo on the VP4. Plex Detune in front of the Trem for a rainy night.

Ready for a gig, even if it's in your bedroom or basement, Cool "Dad Rock" tones from Michael Pickens.

Compressor Pedal, Auto-Engage Wah on Pedal 1, Griddle Cakes Drive, and DM-Two Delay. Leon Todd

Create classic vintage tones with this downtuned baritone sim.

Mono synth with touch filter and distortion plus ring mod octave. Channels too! Use Controllers: Envelope to adjust filter response.
Four channels of shimmering star reverbs, plus four floating clouds, side by side. Auto-swell and Plex delay too! Leon Todd.
Polyphonic Octaves Generator in two flavors plus bonus effects.

Get your funk on with a squishy compressed Envelope Filter, plus pitch and echo options. Every block has 4 channels dialed in.
Vibrato Pedals are back in fashion. Here are multiple examples. Based on a preset by AustinBuddy.

Andy Wood created this clean preset for use with a Woodshed compressor in front of the VP4.

More from Andy Wood... Tele FX. Signature PEQ, plus a sweet Tremolo, Slapback, and Reverb.

Andy Wood lead FX. You can use this with a drive pedal in front of the VP4 or potentially into a crunchy amp.

A nod to il maestro Morricone, with bonus scenes for Rockabilly and Hank's Shadows. Based on a preset by Leon Todd.

Marco Fanton created this preset based on the "Box o' Crunch" drive pedal, designed for a clean platform amp.

Marco Fanton's clean FX preset contains four quintessential clean effects dialed in with channels.

Marco Fanton created this preset based on the "FAS LED-Drive" pedal, designed for a clean platform amp with delay, reverb, and more.
Classic fuzzes, vintage echo, and a phaser with attitude. Dial in Jimmy Page-inspired tones and turn it up.
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I11: Austin Stevie Crank up some Texas tone with these SRV-inspired effects from AustinBuddy.

12: Austin Johnson Tools for getting an "EJ" type clean, dirty, and lead sound, by AustinBuddy.

13: Lowell's Slide The two compressor in series trick heard on so many great slide guitarists records, by AustinBuddy

14: Later Jimi A range of effects inspired by Jimi Hendrix. Based on a preset by "Hippie Tim"

J1: May Day Got a sixpence? Adjust Filter to taste. S3 has a custom harmony (E maj) with creative extras. Use with a clean amp or remove Drive for "Post". Channels too!
J2: VitAmin S An inspired tribute featuring Wah, Whammy, Drive, Detune, Octaves, Delay. Based on presets by "Hippie Tim"

J3: Zapped Based on Dweezil Zappa's Gift of Tone. Dynamic Flanger and Sample/Hold Filter. Adjust Dyna using Controllers > Envelope. Add a wah in front for the real deal.
J4: You Too Buddy? AustinBuddy brings U this preset containing distinctive dot eight delays, SDD preamp, and plex shimmer.

K1: Downtune Capo Virtual Capo set to -1, -2, and -3, plus a "Fake Bass" in Scene 4.

K2: Zero Flange "Zero crossing" will be familiar if you've heard tape flanging on a track like "ltchycoo Park" or "Listen to the Music". Automatic and Pedal 1 versions.
K3: Megataps The Megatap allows up to 128 taps on a single delay line. Hear it in action here.

K4: Digital-al-al-al > Vintage digital delays doing what they do best... best... best.... Leon Todd

L1: Galacticus Verb Extreme space reverbs including one with a pedal 1 "Hold", plus extra effects.

L2: Magneto Echoes Magnetic Delays with tape distortion and compression, plus optional spring reverb.

L3: Aurora Australis Angelic multitap echoes plus appropriate pedal effects before and after. Adjust Master Pan in the MTD for mono or stereo. Leon Todd.

L4: Custom Harmonies  The VP4 allows custom scales to be saved inside the pitch block. Here are a few examples saved as scenes/channels. "Jessica" scale by AustinBuddy.
M1:80s Comp'd Fx The 80s were a decade of excesses, like clobbering guitar effects with post compression like in this preset.

M2:Rhythmic Blissing Fractal Audio "Interns" Owen and Charlie created this cool synchronized effect with heavy modulation and a 16th not "chopper"

M3:Psychadelic '67 Reverse delay adapted from an Axe-Fx Il preset used on the live "Experience Hendrix" tour.

M4:RockMeOn Clean Leon Todd evokes a classic "walkman processor” style clean tone in this throwback designed for a clean amp.

N1: Run Like Heck Inspired by the big rig that sends all others back to mother in a cardboard box. From Cooper Carter.

N2: Floyd Leads Four Floyd Lead effects in this preset from Cooper Carter and the players in Brit Floyd.

N3: Cooper's Toolbox Gigging preset with four dialed-in pre-FX from Cooper Carter.
N4: Feedbaq Mach 3 /P1 Pedal 1 brings 3 different overtones of feedback in this preset by Dweezil Zappa and Matt Picone.
01: Against the Machine You can choose between wah and whammy, both mapped to pedal 1, plus delay and phaser in this raging preset from Cooper Carter.

02: Cosmic Voyage Two delays and two reverbs create dramatic ambient effects in this preset from Cooper Carter.

03: The Beauty Way Larry Mitchell produced this VP4 preset with four scenes based on sounds in his live show.

04: Dual Tape St. Spring Parallel Tape Echoes and dual spring reverbs are featured in this preset from VP4 all-star beta tester @Pedalbuilder
P1: MF FX Post Marco Fanton's Post FX preset contains chorus, delay, plex, and reverb.

P2: AW Stripes Post Andy Wood created this Post FX preset after distortion in his pedalboard rig.

P3: Hair Metal Post Post FX with hairspray and spandex. Based on a preset by "Flyingfadr"

P4: Rack Gods Post Leon Todd's take on a huge rack of post FX.
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Q1:
Q2:
Q3:
Q4:
R1:
R2:
R3:
R4:
S1:
S2:
S3:
S4:
T1:
T2:
T3:
T4:

Lerxst FX Post

JP Loop FX Post
LT FX Post

Mark Day Post
Neal's Post FX
Double Plex Post
Stereo Delays Post
Parallel FX Loop Tpl
Basses Loaded
Bass'd On

Bass-X

Acoustic Toolkit
VP4 | 4CM

Mod Squad 4CM
Gift of Djent 4CM
4CM Parallel Loop

FACTORY PRESETS

Blah blah blah, blah blah blah blah blah blah. Blah blah? Blah BLAH blah blah!

Effects from the Gift of Tone preset by John Petrucci including Rhythm, Chorus, and Lead sounds..

Leon Todd presents a collection of his favorite Post effects here.

Fractal Audio's own Mark Day dialed in this preset containing his favorite post FX. The filter is a foot-switchable boost, with each channel at a different level.
Effects from Neal Schon's "Gift of Tone" preset fine tuned by Cooper Carter.

Huge stereo plex delays in parallel, plus traditional delay and detune adorn this massively wet post fx preset, also from Leon Todd.
"Simple" delays plus extra effects make up this selection based on a preset by Leon Todd.

This template preset is preconfigured for a parallel effects loop. All FX are 100% wet or have "Kill Dry" turned on, and mute when bypassed.
Classic and modern bass effects with channels dialed in.

This ready-to-play bass preset also contains multiple channels of EQ that you can use to instantly sculpt your tone.

Bass-X is way beyond the basics, with Distortion, Envelope Filters, Octaves and Echo!

This simple toolkit contains channels of Compresor, EQ, Chorus, and Reverb ready for acoustic guitars.

This starter preset for 4CM is a re-spin of "A1: Virtual Pedalboard" that's designed for 4CM rigs.

Preset B3 and B4 are combined in a 4CM configuration in this preset.

Based on selections from our popular "Gift of Tone" series, this preset includes pre and post FX ready for use with a 4CM rig.

This 4CM preset is preconfigured for a parallel effects loop. All FX are 100% wet or have "Kill Dry" turned on, and mute when bypassed.
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